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Overview 
 
Historically, wetlands were seen as inhospitable and an encumbrance to humans. In the U.S., we 
have been extremely efficient at draining our wetlands and as a result have lost almost half of our 
wetlands. In some states, more than 90% of the wetlands no longer exist. We now realize that 
wetlands are an extremely important component to our ecosystem. A few of the benefits include: 
acting as a filter for cleaning water, providing flood control, providing habitat for over 300 fish and 
bird species, and acting as a carbon sink. 
 
The U.S. Fish and Wildlife Service (FWS) is the principal Federal agency that provides wetland 
information to the public. Mapping wetlands is a key information component because it allows 
resource managers to develop management plans, assess impacts, develop habitat models, perform 
habitat surveys, and analyze trends. The FWS established the National Wetlands Inventory (NWI) 
in 1974 to provide resource managers with information on the location, extent, and types of 
wetlands. 
 
The NWI for the Great Lakes was accomplished from the late 1970s to early 1980s. Updated the 
NWI for the Great Lakes is imperative for conservation planning and habitat modeling for many 
conservation organizations and natural resource agencies. However, with limited budgets, the FWS 
does not have the funding to accomplish the update. Therefore, a consortium of public and private 
organization is developing wetland mapping standards so that other groups performing wetlands 
mapping can standardize methods for inclusion into the NWI. 
 
Ducks Unlimited (DU) is leading a consortium of partners in the Great Lakes to accomplish an 
updated NWI that can be used for multiple resource activities. DU is also working closely with the 
FWS to develop efficient methods for tracking wetland changes over multiple time periods. The 
goal of the NWI update for the Great Lakes is to provide a current wetlands data layer for habitat 
modeling and resource management, identify potential areas for wetland restoration activities, and 
to provide information on status and trends of wetlands. 
 

Justification 
 
Ducks Unlimited, Inc. (DU) and its partners have recently completed a research project in the Great 
Lakes for breeding mallards. The results of the research were used to develop a planning tool that 
allows resource managers to identify priority areas and acre goals for restoration, enhancement, and 
protection of habitat in order to reach the Upper Mississippi River – Great Lakes Joint Venture 
goals for breeding mallards. When implementing the habitat models and planning tool across the 
Great Lakes, the limiting data layer was the availability of current and consistent wetland 
information. This problem was recognized when comparing the 2001-2003 field information from 
the mallard study to the NWI data. A current wetlands layer was also the limiting data layer in 
another project on identifying all-bird conservation areas in the Western Lake Erie basin and the 
Saginaw Bay Watershed. Additionally, DU and its partners are currently working on a two-year 
research project on spring stopover sites for waterfowl and shorebirds – where wetland types play a 
vital role.  
 
In light of the past experience and anticipated future use of the NWI data, DU completed a pilot 
project to update the NWI layer for part of Michigan with funding from the U.S Fish and Wildlife 
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Great Lakes Coastal Program and the Upper Mississippi River – Great Lakes Joint Venture. The 
pilot project was performed to test the methodology for updating the NWI utilizing on-screen 
digitizing and digital orthophotos over a large geographic area. The pilot project was successful and 
has led to engaging other organizations (due to limited FWS funding) in implementing the update 
for the Great Lakes. The need for this information is great and diverse as can be determined from 
the current list of cooperators involved in the project – from transportation to environmental to 
recreational. 

 

Wetland Data 
The primary source data for this project is the U.S. Fish and Wildlife Service’s National Wetlands 
Inventory (NWI) which was accomplished using aerial photos from the late 1970s to 1980’s (see 
Figure 1).  The NWI does not exist for Wisconsin because the Wisconsin DNR was performing a 
wetland inventory at the same time.  For Wisconsin, the Wisconsin Wetlands Inventory will be used 
for the update.  For Ohio, some of the NWI is not in digital format and therefore needed to be 
scanned and rectified before the update could occur. 
 

 
Figure 1.  Dates of the aerial photos for the original NWI delineation 
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NWI Data  
 
A seamless National Wetlands Inventory (NWI) data set is housed and administered by the United 
States Geological Survey (USGS) in a Master GeoDatabase (USGS MGD) for the FWS. This data 
set contains the most recent digital NWI data for the United States. When updated NWI data is 
delivered to the FWS, it is uploaded into the USGS MGD and the original NWI data is archived. 
 
For the State of Ohio, there are 610 USGS 1:24,000 quads that are not in the USGS MGD because 
they are currently only available in hardcopy format. Most of the state of Wisconsin is also not in 
the USGS MGD. NWI data was not done for Wisconsin because the State of Wisconsin was already 
creating a wetlands layer – Wisconsin Wetlands Inventory (WWI). Complete coverage of Illinois, 
Indiana, and Michigan are currently in the USGS MGD. 
 
Ducks Unlimited received from the USGS a DVD with an ArcSDE export (check out date: 
February 1, 2006) of the USGS MGD for the lower 48 States. This export was loaded into Ducks 
Unlimited’s SDE database and clipped to the five state area using USGS 1:24,000 quads as the 
bounding area (referred to as DU MGD throughout the remainder of the document). 
 

Ohio NWI Scans 
 
The NWI data for much of Ohio is still in hardcopy format (Figure 1). Therefore, the additional step 
of creating the digital data is necessary before the update can occur. The FWS and Ohio Geological 
Survey has provided DU with the 1:24000 scanned mylar sheets of the hardcopy NWI data in raster 
format.  

 
Figure 1. NWI status for Ohio. 
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Each of the 610 scanned NWI quads for Ohio was registered to USGS 1:24000 topographic maps in 
Albers Equal Area Projection using the four corners of the quad boundary. The rectification process 
also clipped the scanned image to the quad boundary, removing all the unnecessary text from the 
scanned quads. These rectified quads will then be merged into a seamless raster image for Ohio. 
The wetland polygons will then be digitized by viewing the registered, seamless, raster, NWI 
images over the digital orthophotos. Any spatial errors in the raster NWI images will be adjusted to 
the orthophotos. The NWI updating process will then occur using these original NWI polygons. 
 
For the State of Ohio, there are 610 USGS 1:24,000 quads of NWI data that were never converted 
into a digital GIS layer. All but 14 of the 610 mylar hardcopy NWI quad maps were scanned by the 
FWS into TIFF format. The remaining 14 quads (Alvordton, Assumption, Berkey, College Corner, 
Fairhaven, Fayette, Lyons, Morenci, Nettle Lake, New Paris, Pioneer, Southeast Columbus, 
Sylvania, Whitewater) were scanned by the Ohio Geological Survey into TIFF format. DU has 
received all 610 scanned NWI quads for Ohio. 
 
Much of Ohio does not have digital NWI data. However, the FWS has scanned the hardcopy mylar 
NWI maps. The first step was to register the scanned NWI maps so they could be overlaid with the 
orthophotography for the digitization process. The registration process used Erdas Imagine to 
register the scanned maps to Albers projection using the four corner tics of the scan and the UGSG 
1:24k quad boundary. Note: the registration process will not be exact – so there will be positional 
errors on the rectified scanned NWI. These errors will be corrected when the wetlands are digitized 
and updated over the DOQQ imagery. 
 
Folder structure 
The main files for the project are located on the DU GLARO server under W:\OH_NWI. There are 
3 folders;  

• The original_files folder contains .zip files of the scans as they were and will be used as 
a backup.  

• The nwi_rectfied_scans contains the scans in imagine format after the scan has been 
recified. 

• The NWI_raster_scans folder are the working versions of the scanned hardcopy NWI 
maps. This folder contains 3 sub-folders; merged_scans_backup, Incl_Attributes and 
Separate_Attributes.  

 
Scan preparation 
Some of the NWI quads that were scanned by the US FWS were scanned into two separate files 
(one with the NWI polygon and line work and one with the attributes. The remaining NWI quads 
were scanned with both the NWI polygons, line work and attributes in one file. The first step was to 
combine the polygon bitmaps with the corresponding attribute bitmaps. The files in the 
Separate_Attributes folder are bitmaps with names like: 38082-E5_kitts_hill_oh.bmp and 38082-
E5_kitts_hill_oh_att.bmp. The number (in this case 38082-E5) is the USGS 1:24k Quad number. 
The name (Kitts Hill) is the 24k quad name. For every quad there will be two separate files; the 
oh.bmp which are the scans of just the polygons and the oh_att.bmp which are the attributes. 
 
Open the oh.bmp in Adobe Photoshop. Click on the Image menu and select Mode and Grayscale 
(click ‘OK’ when the pop-up appears). In the layers pallet, double-click where is says background 
and hit ok when pop-up appears. It should now say layer 0 where background was, and the layer 
should be unlocked (the little padlock icon will be gone). 
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Image Menu 

Tool Pallet 

 
 
Leave the oh.bmp open and open the att.bmp. Repeat the process above for this image. The double-
click where it says layer 0 in the tool pallet. A window will open with two sliders at the bottom. 
Move the top one of these two sliders all the way to the left (into the black) until background 
disappears. Then hit ok. It will look like the image is gone, but if you zoom in you will see it is still 
there. 
 

 

Move this slider all the way over 
into the black until background 
disappears. 

 
 
Select the move tool  from the toolbar, drag the att.bmp onto the oh.bmp. 
Move the images until the corners are close (you will have to zoom in to see well). 
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The corners on the image 
look like this – disregard 
all the text at the bottom, 
that will be removed later. 

 
 

 

Align the corners so they 
are very close. 

 
 
When you align one corner, the other corners may be off. There are a few different tools in the Edit 
menu under Transform you can use. The rotate tool will let you freely rotate the layer, just 
move your cursor to the edge of the image and it should turn to the icon shown to the right 
then just drag slowly in the direction you want to rotate. Sometimes it takes a lot of processor 
to perform this function, so you may not be able to “preview” the move until you stop dragging it. 
 
The other tool is the distort tool. Like the rotate tool you have to be at the edge of the image to use 
it. The cursor will turn from black to a speckled gray – then you can click and drag. 
When you try to zoom or pan it will ask if you want to apply the transformation – click yes. 
You will likely have to go from corner to corner adjusting the image. It does not have to be perfect, 
we only need to be able to tell which label is pointed to which feature. 
 
Once the corners all seem to be lined up as good as they can, it doesn’t hurt to pan around the image 
and see if the labels make sense where they point at features – again it doesn’t have to be perfect, 
but just look for any glaring errors. 
 
Now save the oh.bmp into the merged_scans_backup folder as a .tiff. This will make a backup of 
the image with the two separate layers if we need to go back to it later. If this file starts to take up 
too much room, burn the files to DVD and delete them from the hard drive. 
 
Save the oh.bmp file again, this time into the Incl_Attributes folder as a .bmp. Reopen the file you 
just saved, click on the Image menu and select Mode and Grayscale (hit ok when pop-up appears). 
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In the layers pallet, double-click where is says background and hit ok when pop-up appears. At the 
bottom of the palette window there is a half white/half black circle. Click on that and select invert. 
This should turn the text white and the background black. Save this file over the existing bitmap. 
This will be our working version. 
Now it is safe to delete the oh.bmp and att.bmp files for the finished quad from the 
Separate_Attributes folder. 
 
Scan Rectification 
In order to overlay the scanned NWI maps with the aerial photos in ArcMap, they must be given 
real world coordinates – or registered. To do this, open Imagine and two viewers and make them 
similar sizes and side by side. In the 1st viewer add the quad bitmap from the Incl_Attributes folder. 
In the 2nd viewer add the 24k quad shapefile. 
 

 
 
From the Data Preparation menu, select Image Geometric Correction. Then make sure From Viewer 
is selected and click select viewer in the set input window and click in the 1st viewer (the bitmap). 
Select the Polynomial option from the set geometric model window. Then just drag the polynomial 
properties window out of the way. 
Click on the GCP tool from the Geo Correction Toolbar (right).  
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Select Existing Viewer in the GCP Tool Reference window, hit ok and click inside the 2nd viewer 
(quads). 
 
In the quad frame select Vector – attributes. Scroll through to find the quad you are interested in and 
select it. Close the attribute table and zoom in on the selected quad. 
 
Zoom way in on the corner mark of the bitmap and the same corner of the quad shapefile. Select the 
GCP tool and place a point in the corner of the bitmap. The GCP tool should not go to point #2 until 
you create a point in the quad viewer – if it does select the GCP line 1 and then select the GCP tool 
again and drop a point in the corner of the quad shapefile. Repeat this process for all 4 corners (after 
the third set of points are placed, when the 4th is dropped in the bitmap side the corresponding point 
should appear in the quad viewer). Once all the corner points are in, zoom as far in as you can on 
each of the quad corners and adjust the points. Then hit the Window pane icon in the GCP 
Correction tools and save the file in the nwi_rectified_scans folder as the name of the quad. 
 
Once the file is done exporting, it can be opened in ArcMap. Open the properties – symbology and 
select unique values. You can remove all the values except 255 – then change the color to red or 
something you can see. Zoom in on some polygons or rivers and load a fairly detailed 8m or less 
teraserver doqq to make sure the image lines up decent. 
 
Mosaic and Modeling Process 
After the rectification process we had all the quarter quads named and separate from each other. The 
next process we used was in Erdas Imagine. The mosaic tool was used to mosaic the separate quads 
into (21) specific areas. These areas contained roughly (32) quarter quads each. After each mosaic 
process the new area would then need to be cropped down to its extent using Erdas Imagines 
Modeling tool. The modeler allowed us to shrink the file size and to remove any extent that was not 
necessary. In the modeler unsigned 2-bit was used as the data typed used on all the modeling that 
was done. A inquire box was used to select what was needed to reduce the extent. 
 
Once all (21) areas had been modeled the next step was then to combine those areas into larger 
areas. The same process was used once again. Each of the new areas (5 in total) was mosaic 
together and then the model tool was used to remove any unnecessary extent and to create a smaller 
file. We ended up with (5) separate areas that covered the Ohio area.  
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Figure 3: NWI Rectified Raster Scans for Ohio 

 
 

Aerial Photos 
Both spring and summer aerial photos will be used in the update process. The spring photos are best 
to identify the seasonal wetlands and forested wetlands and the summer photos are best to identify 
the emergent, aquatic, and farmed classes. The spring photos were typically acquired from state 
agencies that contracted the photo flights. The summer photos were acquired from the Farm 
Services Agency’s National Agricultural Imagery Program (NAIP). Digital Elevation Models 
(DEM), hydric soils (from NRCS SSURGO data), and USGS Topographic maps may also be used 
when available to aid in the updating process. For more information on the data and contacts for 
each of the sections below, see Appendix B. 
 
The Ohio NWI data will be updated and digitized using spring CIR photos from 2006 for the 
northern part of the state and 2007 for the southern part of the state as well as summer natural color 
photos from 2004 (NAIP). In addition, a high resolution Digital Elevation Models (DEM) will be 
available for the state to aid in the updating process. 
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Ancillary Data 
In cases where the wetland interpretation of the aerial photos is not clear, ancillary data can be 
useful in determining the existence and class of the wetland.  Ancillary data sets include 
topographic maps, hydric soils, SSURGO Special features, and wetland restoration project sites. 

USGS Topographic Maps 
 
The digital raster topographic maps can be beneficial when identifying wetlands by looking at the 
contour lines (wetlands don’t generally occur on slopes) and wetland symbols. 
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Hydric Soils 
 
The Hydric soils attribute from the county level SSURGO soils can be beneficial when identifying 
wetlands because most wetlands are going to occur on hydric soils. 
 

 
 

No NWI wetland identified, but hydric soils present

SSURGO Special Features 
 
The SSURGO Special Features identifies special features (including wetlands) that are too small to 
map within the soil polygons.  Much like the wetland symbols on the topographic maps, this layer 
can be useful identifying small wetland areas. 
 

Wetland Restoration project sites 
 
Ducks Unlimited has a point file for all of its wetland restoration projects.  This layer can be helpful 
in identifying newly created wetlands and determining the wetland class. 
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Project Timeline 
 
The agreement was signed between the Ohio Department of Natural Resources and Ducks 
Unlimited on September 13, 2006.  The project completion date is June 30, 2009 with the final 
report due on November 1, 2009.   
 

Project Budget 
 
The total cost to update the National Wetlands Inventory for the state of Ohio was $339,920.  Ducks 
Unlimited received a grant for $275,420 from the Ohio Department of Natural Resources (Ohio 
Consortium), for $12,500 the National Fish and Wildlife Foundation (via US EPA Great Lakes 
Program), and $52,000 from the U.S. Fish and Wildlife Service.   
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NWI Master Geodatabase 
 
The USGS administers a seamless version of the NWI as part of the National Map in an ArcSDE 
master geodatabase for the FWS. The NWI master geodatabase is in Albers Equal Area projection. 
All updates will conform to this projection system. DU received an export of the NWI MGD from 
the USGS and imported the geodatabase into DU’s MGD. The exported NWI geodatabase included 
all the available digital NWI data for the lower 48 states. This database was subset to all the USGS 
1:24000 quads that intersect DU’s Great Lakes/Atlantic Region.  This project will follow the 
guidelines in the “Wetlands MGD Check-out Instructions” as developed by the FWS and USGS. 
 

Database Setup 
 
The National Wetlands Inventory (NWI) data is stored within a single database at Ducks 
Unlimited’s Great Lakes/Atlantic Regional Office. The database, entitled ‘vector,’ was created 
using ESRI ArcSDE 9.1 SP1 and Microsoft SQL Server 8.0 software and resides on DU’s GLARO 
network on the glaro_sde server. 
 
The first steps performed upon configuration of the database server and data drives were to install 
the database software, create the geographic data repository, and configure backups. Specific steps 
are outlined below: 
 

Software Installation 
 

1. Microsoft SQL Server 8.0 was installed using Windows authentication. Tempdb is located 
on the F:\ drive. 

2. ESRI ArcSDE was installed. 
 

Database Creation 
 

3. In SQL Server Enterprise Manager, a new database named ‘vector’ was created to hold 
vector datasets used at GLARO. The default Primary file location of G:\MSSQL\Data was 
accepted. The location of the transaction log was changed to E:\ in order to separate it from 
the datafile drive.  

4. Three filegroups were created. The SDE filegroup was made to contain the database’s SDE 
system files. The NWI filegroup was made to contain the NWI data. Finally, the TOPO 
filegroup was created to hold the topological data associated with the NWI data. A single 
data file was created for each in G:\MSSQL\Data. 

5. Three separate database roles were created. The dataowner role was created for data 
ownership. The dataeditor role was created to allow edits to the data. Lastly, the 
databrowsers role was created to permit simple data viewing.  

6. The ESRI ArcSDE post-installation software was run to create the SDE repository, to 
authenticate the software, and to create a service. 

7. Finally, the dbtune.sde file was edited to reflect the filegroup specifications outlined above. 
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Database Object Creation 
 

Feature Class Creation 
The U.S. Fish and Wildlife Service (FWS) delivered to Ducks Unlimited its NWI data as an SDE 
export file (wet_poly_feb_1_2006) containing all wetlands within the United States. To better 
manage this data in the context of this project, wetlands outside Ducks Unlimited’s Great 
Lakes/Atlantic Region Office region were deleted and new fields were added to record the update 
process. This was done by importing the entire dataset, creating a duplicate shell schema with no 
data, and appending desired data into the shell. The creation of a new feature class with these new 
fields is outlined below: 
 

1. The sdeexport file was imported using the following command:  
 
sdeimport -o create -l c_wet_poly_feb_1_06,shape -f \c_wet_poly_feb_1_06.000 -k nwi -i 
vector_sde -u glarogis -p ********  
 

2. The sdeexport file schema was exported by specifying a where clause condition that is not 
met by any data. The following command was executed with the indicated results:  
 
C:\arcgis\ArcSDE\sqlexe\bin>sdeexport -l c_wet_poly_feb_1_06,shape -a all -f  
 
C:\arcgis\ArcSDE\sqlexe\sdeexports\wet_poly_schema.sdx -w "ATTRIBUTE = 'xxx'" -i 
vector_sde -u glarogis -p ********  
  
ArcSDE 9.0 SQL Server Build 1926 Fri Mar 19 13:29:17 PST 2004  
SDEX File Export Administration Utility  
-----------------------------------------------------  
Exporting ArcSDE object to "C:\wet_poly_schema.sdx" in SDEX 9.0 export format ...  
Exporting table "c_wet_poly_feb_1_06".  
Spatial column "SHAPE"  
No matching records found or table is empty.  
Only the table's schema information is exported.  
0 features converted.  
0 features exported.  
 

3. The sdeexport file schema was imported into the vector database. The new feature class was 
created and named ‘wet_poly.’ The following command was executed with the following 
results: 
 
C:\arcgis\ArcSDE\sqlexe\bin>sdeimport -o create -l wet_poly,shape -f 
C:\arcgis\ArcSDE\sqlexe\sdeexports\wet_poly_schema.sdx -k nwi -i vector_sde -u glarogis 
-p ********  
  
ArcSDE 9.0 SQL Server Build 1926 Fri Mar 19 13:29:17 PST 2004  
SDEX File Import Administration Utility  
-----------------------------------------------------  
Importing SDEX from C:\arcgis\ArcSDE\sqlexe\sdeexports\wet_poly_schema.sdx ...  
Importing spatial column "shape"  
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0 record read.  
0 record stored.  
 

4. Features within the Ducks Unlimited’s GLARO region were appended to the wet_poly 
feature class: 

a. Merged USGS 24k shapefile features in GLARO region with 
W:\GLARO\SDE_DATA\quad_areas.shp features that cover shoreline areas not in 
USGS coverage to create coverage of GLARO region. Output as 
W:\GLARO\SDE_DATA\quadareas_union.shp. 

b. Selected quad features by state. 
c. Selected c_wet_poly_feb_1_06 features that have their center in selected quad 

features. 
d. Using ArcToolbox Data Management Tools/General/Append, appended currently 

selected features to wet_poly. 
e. Cleared selected features. 

 
5. Additional fields deemed necessary for the documentation of the update process were added 

to the feature class. The added fields are: 
 
NWI_KEY    LONG INTEGER  
STATUS    SHORT INTEGER  
CONVERSION_TYPE  STRING (1)  
PARTIAL    STRING (1)  
IMAGE_DATE   STRING (15)  
INACTIVE_DATE   STRING (15) 
FIELD_VERIFIED   STRING (1)  
COMMENTS    STRING (255)  
UPDATE_OPERATOR  STRING (50)  
UPDATE_DATE   DATE  
 

6. A ‘status’ subtype was created to apply topological restraints within the ‘active’ and 
‘inactive’ subsets. To assign a topology rule to such subsets of data, a subtype must be 
defined for the field. Therefore, a status subtype was assigned for the STATUS field. 
 

7. Domains were created and assigned to support the projects data management guidelines. The 
following domains were created: 
 
Field(s): STATUS  
Domain: Status  
Field Type: Short integer  
Code/Description: 0/ACTIVE  
Code/Description: 1/INACTIVE  
  
Field(s): CONVERSION_TYPE  
Domain: CONVERSION_TYPE  
Field Type: Text  
Code/Description: A/AGRICULTURE  
Code/Description: D/DEVELOPMENT  
Code/Description: R/RECREATION  
Code/Description: O/OTHER  
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Field(s): PARTIAL, FIELD_VERIFIED  
Domain: Y/N  
Field Type: Text  
Code/Description: Y/YES  
Code/Description: N/NO  
  
Field(s): ATTRIBUTE  
Domain: ATTRIBUTE  
Field Type: Text  
Code/Description: tbd  
  
Field(s): UPDATE_OPERATOR  
Domain: UPDATE_OPERATOR  
Field Type: Text  
Code/Description: (per user)  
 

8. A feature dataset was created to hold the wet_poly feature class and its necessary 
topological rules. The dataset’s spatial extent was defined by importing the wet_poly feature 
class’ extent. 
 

9. The topological rules for the wet_poly feature class’ STATUS field subsets were created. 
Features with the attribute ‘active’ within the STATUS field were given the topology rule: 
“must not overlap.” Likewise, features with the attribute ‘inactive’ within the STATUS field 
were given the topology rule: “must not overlap.” 
 

10. The attribute values for certain fields were populated at the beginning of the update process. 
The populated fields and their assigned values are listed below: 
 
Set status for all features = 0/Active  
Set NWI_KEY = OBJECTID  
Correct 'ATTRIBUTE' values  
 

11. To utilize the NWI Object Inspector, an editing tool designed by GLARO to better enable 
and standardize the update process (explained within the Process Management section of 
this document), a change was made to an SDE system table for the wet_poly feature class 
and checked-out feature classes. The GDB_ObjectClasses table was opened, and in the 
record with name ‘WET_POLY,’ insert the following in the EXTCLSID field:  
 
{D6956100-2A7F-4999-B766-682E79BEB4FA}  
 
 

Parent Table Creation 
12. It was deemed necessary to record all parent-child feature relationships within the updated 

NWI dataset. Therefore, a single table was created to record all parent-child relationships. 
The new table was created using the glarogis schema. The table was created by executing 
the following commands: 
 
CREATE TABLE PARENT  
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(  
    nwi_key int,  
    parent_key int,  
    unique (nwi_key, parent_key)  
) ON NWI;  

 

NWI_SEQ Table and Procedure 
13. To ensure that newly created features within the updated NWI dataset are provided a unique 

identifier, as were features within the original dataset, a database object was created that 
would provide each newly created feature with a new and unique ‘NWI key.’ The 
NWI_SEQ table was created using the glarogis schema to provide NWI keys to newly 
created features. The table was created by executing the following commands: 
 
create table nwi_seq (ID int)  
insert nwi_seq select 14079586  
  
create procedure nextval  
@ID int output  
as  
update nwi_seq set ID = ID + 1, @ID = ID + 1  
go  
 

 

Database Backups 
 
The vector database on glaro_sde is used to store and serve data. Data is not typically edited directly 
in the database. Instead, data is updated in a disconnected repository, with updates applied to a layer 
in one operation. Because the data is not actively edited in the database, log file recovery is not 
needed. Therefore, the vector database is set to the Simple recovery model. A full backup is taken 
every weekend, with differential backups taken every night. Additionally, the log file is truncated 
nightly.  
 
GLARO uses the vector database to store and serve multiple feature classes not pertaining to NWI. 
Therefore, in the event of an editing or data synchronization error, it may not be prudent to restore 
the entire database in order to retrieve one data layer. Consequently, the wet_poly feature class, 
which is the only feature class that undergoes regular edits, is exported every weeknight. Exports 
are saved for a full week, after which point they are overwritten. Also, one export per week and one 
export per month are archived. If necessary, these exports may be used to restore the wet_poly 
feature class only. 

Database Maintenance 
 
The wet_poly layer and database undergo periodic maintenance for which all users check in their 
edits that are then reconciled and posted. After all versions are deleted, the database is compressed 
(as the SDE user) and the layer is unregistered as versioned (as the dataowner). This writes all data 
updates to the wet_poly table. After this is done, the wet_poly feature class is analyzed and the 
feature dataset is then re-registered as versioned. 
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As routine, the parent table is inspected for NWI key/parent key combinations recorded that no 
longer exist. Periodically, queries are run to verify that the NWI key and parent key features both 
still exist. Orphaned records are deleted. 
 

Geodatabase Versioning 
 
The DU MGD administrator is the only person that has permission to edit the DU MGD. The DU 
MGD will be registered as versioned, which will allow multiple users to edit the data 
simultaneously. Analysts will edit a version of the master database, not the actual database (see 
Figure 1). The version will appear the same as the original, however, instead of being a copy or 
modifying the original data, edits are stored in separate geodatabase system tables. The DU MGD 
administrator will only post edits after any conflicts have been reconciled and the edits have been 
checked for quality (see QA/QC section). 
 

Data Editors 
 
As GLARO employs a multitude of interns and volunteers to assist in the update process, additional 
data editors are commonly added. The following steps detail the creation of a new NWI Update data 
editor: 

Create a login for the new data editor 
1. Open the SQL Server Enterprise Manager on glaro_sde.  
2. Expand navigation tree to Local Server > Security > Logins  
3. Right-click on 'Logins' and select 'New Login…' Make the following entries and click 'OK':  

Login name  
SQL Server Authentication  
Password  
Database: vector  

 

Create a user account for the new data editor 
4. Navigate to Local Server > Databases > vector > Users  
5. Right-click on 'Users' and select 'New Database User…' Make the following entries and 

click 'OK':  
Login name: Select login created in step 1.  
User name: User name will automatically populate with the login name.  

6. Database role membership: public will be checked by default, also grant the sde_dataeditor 
role. 
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Data Model 
Geodatabase Feature Dataset 
Spatial Reference is as follows: 

 
Projected Coordinate System:  
Name: NAD_1983_Albers 
  Alias:  
  Abbreviation:  
  Remarks:  
Projection: Albers 
Parameters: 
  False_Easting: 0.000000 
  False_Northing: 0.000000 
  Central_Meridian: -96.000000 
  Standard_Parallel_1: 29.500000 
  Standard_Parallel_2: 45.500000 
  Latitude_Of_Origin: 23.000000 
Linear Unit: Meter (1.000000) 
Geographic Coordinate System:  
  Name: GCS_North_American_1983 
  Alias:  
  Abbreviation:  
  Remarks:  
  Angular Unit: Degree (0.017453292519943299) 
  Prime Meridian: Greenwich (0.000000000000000000) 
  Datum: D_North_American_1983 
    Spheroid: GRS_1980 
      Semimajor Axis: 6378137.000000000000000000 
      Semiminor Axis: 6356752.314140356100000000 
      Inverse Flattening: 298.257222101000020000 
 
X/Y Domain:  
  Min X: -3350595.000000 
  Min Y: -729611.000000 
  Max X: 18124241.450000 
  Max Y: 20745225.450000 
  Scale: 100.000000 

Data Dictionary 
 
One of the challenges in updating the NWI is to design a system that tracks the historic wetland 
information so that wetland trends and potential restoration sites (wetlands that have been 
converted) can be identified. A solution was developed by adding attributes to the current database 
that identified the converted and partially converted wetlands. These additional attributes allow for 
flexibility in selecting current NWI polygons, historic wetland polygons, or a combination of both. 
This system also allows for easy tabulation of the current status of wetlands, wetland trends, and 
identification of converted wetlands for potential wetland restoration activities. Therefore, several 
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attribute fields will be added to the DU MGD (see Table 1 and Figure 1). For a more detailed 
description on how the attributes are used, see the “Update Procedures” documentation. 
 
The updated NWI database includes a number of attributes for each wetland feature. Some of these 
attributes were of the original NWI data. However, as previously discussed in this document, 
GLARO added a number of attributes to assist in the documentation and management of the update 
process. A full list of attributes and their definitions follows: Those in italics were added to the 
FWS layer by Ducks Unlimited. 
 

WET_POLY     
OBJECTID OID (4)   
ATTRIBUTE STRING (20)   
HGM_CODE STRING (10)   
QAQC_CODE STRING (9)   
WETLAND_TYPE STRING (50)   
ACRES DOUBLE (8)   
DECODE STRING (40)   
NWI_KEY LONG INTEGER   
PARENT_KEY LONG INTEGER   
STATUS SHORT INTEGER 0/1 
CONVERSION_TYPE STRING (1) A/D/R/O 
PARTIAL STRING (1) Y/N 
IMAGE_DATE STRING (15)   
INACTIVE_DATE STRING (15)   
FIELD_VERIFIED STRING (1) Y/N/NULL 
COMMENTS STRING (255)   
UPDATE_OPERATOR STRING (50) * 
UPDATE_DATE DATE DEFAULT 
SHAPE GEOMETRY (4)   
SHAPE.area DOUBLE (0)   
SHAPE.len DOUBLE (0)   

 
OBJECTID   Automatically generated feature id. 
ATTRIBUTE  Habitat classification 
HGM_CODE  Code generated by the U.S. Fish and Wildlife Service 
QAQC_CODE  Code generated by the FWS QA/QC tool 
WETLAND_TYPE Text field describing the NWI wetland  
ACRES   Acreage  
DECODE   Link to the NWI online decoder  
NWI_KEY  Unique id for wetland features  
STATUS   Current status of the feature, either Active or Inactive  
CONVERSION_TYPE Purpose for which a wetland was converted, either Agriculture, 

Recreational, Development, or Other  
PARTIAL   Was derived from a prior wetland 
IMAGE_DATE  Vintage of imagery used to create polygon  
INACTIVE_DATE Vintage of imagery used when polygon was inactivated 
FIELD_VERIFIED Whether or not the wetland has been verified in the field, either Yes, 

No, or Null  
COMMENTS   Comments 
UPDATE_OPERATOR  User that made updates 
UPDATE_DATE  When updates where made 
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Primary/Foreign Keys, Cardinality, Relationships 
 
There is a many to many relationship between the wet_poly table and the parent table. The nwi_key 
field in the wet_poly object is the primary key while the nwi_key field in the parent table is the 
foreign key. 
 

Domains 
 

Field(s): STATUS 
Domain: Status 
Field Type: Short integer 
Code/Description: 0/ACTIVE 
Code/Description: 1/INACTIVE 
 
Field(s): CONVERSION_TYPE 
Domain: CONVERSION_TYPE 
Field Type: Text 
Code/Description: A/AGRICULTURE 
Code/Description: D/DEVELOPMENT 
Code/Description: R/RECREATION 
Code/Description: O/OTHER 
 
Field(s): PARTIAL, FIELD_VERIFIED 
Domain: Y/N 
Field Type: Text 
Code/Description: Y/YES 
Code/Description: N/NO 
 
Field(s): ATTRIBUTE 
Domain: ATTRIBUTE 
Field Type: Text 
Code/Description: (per user) 
 
Field(s): UPDATE_OPERATOR 
Domain: UPDATE_OPERATOR 
Field Type: Text 
Code/Description: (per user) 
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Chapter 3 – Editing Environment 
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Database Connection 
 
This section details how to set up the editing environment in ArcGIS. These steps need to be 
performed one time only. 
 

Step 1: Set up Database Connections in ArcCatalog  
 

1. Launch ArcCatalog  
2. Expand Database Connection in the catalog tree, double-click on 'Add Spatial Database 

Connection', enter the following parameters in the dialog, and click 'OK': 
 

 
3. Repeat Step 3, using Service: 5152, but leaving ‘Save Version’ checked: 
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Step 2: Add Editor and Disconnected Editing toolbars 
If the Editor and Disconnected Editing toolbars are not present in the ArcMap user interface, they 
need to be added. First, check for the presence of the following toolbars: 

 
If one or both do not exist, go to View > Toolbars and check 'Editor' and 'Disconnected Editing'. 
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NWI Object Inspector Installation 
 
Edits made to feature classes that are derived from the wet_poly layer must be made using the NWI 
Object Inspector. This custom attribute editor includes changes to the attribute dialog, plus actions 
triggered by editing events. 
 

Installation 
1. Navigate to \\Drake\Archive\Installs\GIS Misc\NWI\NWI Object Inspector and execute 

Setup.exe. Follow the steps in the installation wizard to install the application. 
2. Edit the registry 

a. Go to Start > Run, and type ‘regedit’. Click ‘OK’. 
b. In the Registry Editor, navigate to My 

Computer\HKEY_LOCAL_MACHINE\SOFTWARE\DU\NWI: 

 
 

c. Edit each of the three registry keys by double-clicking on the ‘Name’ value, editing 
the text, and clicking ‘OK’. 

i. Attributes Enter attribute values desired in the Attribute combo 
box. Separate each value with a comma. 

ii. ImageDate Enter the vintage of the background imagery for the 
state you will be working 

iii. UpdateOperator Enter your database username. This follows the 
naming convention <first_initial><last_name>. 
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Using the Object Inspector 
 
The Object Inspector is the tool that ArcMap uses to edit the attributes of a selected feature during 
an edit session.  DU has customized the standard Object Inspector for the NWI update to improve 
the efficiency of the update process. 

Edit Session 
 
Upon commencement of an editing session, the Object Inspector will determine whether you are 
editing NWI data or not. If you are making NWI edits, it will automatically capture edit events that 
properly manage your data. 
 

Attribute Edits 
 
All attribute edits made during an edit session must be made through attribute edit window (Object 
Inspector). Do not make any attribute edits via other means: 

 
 
Edits to Multiple Features 
 
Just as with the standard attribute editor, edits can be made to multiple features at once. To do so, 
click on the layer header in the left panel. Edits made to any attribute will apply to all selected 
features: 
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Global Variables 
The global variables need to be set when the analyst first starts a county.  The update operator will 
be set based on the login name, be sure this is set to the proper name.  The image date will be the 
date that is filled in for the Inactive Date if a polygon is inactivated or for the Image Date if a new 
polygon is created.  For Northern Ohio, the image date should be set to 2006 and southern Ohio, 
2007.  Indiana and Illinois the image date should be set to 2005.  For Michigan, the image date 
should be set to 1998, with manual updates to 2005 when changes occur.  Attributes that occur 
frequently (ponds – PUBGx) can be placed in the attributes box.  These attributes will show up in 
the pull down menu for quick assess.  There are over 2,000 unique NWI attributes, so it would not 
be efficient to put all of the attributes in the pull-down menu. 
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Edit Operations 
 
The nwi key and parent key(s) are managed during Create Feature, Copy/Paste, Cut, and Clip 
Polygon edit operations. During all other edit operations, the nwi key and parent key(s) must be 
managed manually.  
 
Create Feature 
When a feature is created, the Object Inspector automatically populates the NWI key, Status, and 
Image date. 
 

 
 
Copy and Paste 
When a feature is copied and pasted, the copied feature is automatically made inactive, and the 
parent key for the new feature is set to the nwi key of the copied feature. 

Automatically 
populates the 
NWI Key, 
Status, and 
Image Date 

Automatically 
populates the 
NWI Key, Parent 
Key, Status, and 
Image Date for 
the new polygon, 
and inactivates 
the original 
polygon 
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Clip Polygon 
When a feature is clipped, the Object Inspector automatically populates the NWI key, Status, Image 
Date, and Parent Key, if applicable. 

 
 

Automatically 
populates the 
NWI Key, Status, 
Image Date, and 
Parent Key if 
applicable 

Attribute 
 
The attribute field contains a drop-down list of often-used values (add new values in the Global 
Variables tab). Any of these values may be selected, or the user may type in a new value. The list 
may be edited by added and deleting codes from the Global Variables tab. 
 

NWI Key 
 
The NWI Key is locked from editing by the user. This field is autopopulated by the application for 
new features. The value in this field can be copied and pasted into the parent key field. See section 
on “NWI Key Updates” if you need to change the NWI key for a feature. 
 

Manual NWI Key Updates 
 
For special cases where NWI Keys were not automatically updated, a utility has been created to do 
so. 
 

Installation 
1. Open ArcMap and create a map document that includes the NWI personal geodatabase 

feature class that will receive updates. 
2. Open the ‘Customize’ dialog > Comments tab. Select the target map document or template. 
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3. Click ‘Add from file’, navigate to V:\Installs\GIS Misc\NWI\UpdateNWI and select 
UpdateNWI.dll. 

4. Drag the UpdateNWI command button onto the toolbar: 

 
 

Use 
5. Select the features to be updated. 
6. Click on the ‘NWI’ button. 

 
Note: The Update NWI tool will function whether there is an active edit session or not. If there is an 
active edit session and the Object Inspector is visible when the tool is run, the Object Inspector will 
not be present when the tool completes, even though the edit session will still be active.  
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Chapter 4 – Overview of Updating Process 
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The NWI layer will be updated using spring and summer digital orthophotos. The spring photos are 
best to identify the seasonal wetlands and forested wetlands and the summer photos are best to 
identify the emergent, aquatic, and farmed classes. Digital Elevation Models (DEM), hydric soils 
and USGS Topographic maps may also be used when available to aid in the updating process. Only 
wetland polygons will be updated (no lines or points), as the Wetlands MGD Check-out Instructions 
(USFWS, 2004) state; “Linear delineations of wetlands are discouraged” and “The wetlands MGD 
will no longer support wetland point features.” 
 
The updating process will involve displaying the original NWI layer on top of the digital 
orthophotos on a section-by-section basis (1 square mile, approximately 1:10,000). The minimum 
mapping unit for the update is approximately one-tenth of an acre. The photos will be interpreted as 
to whether the wetland still exists, if it has changed class, has been spatially modified, or remains in 
the same condition as the original.  A unique system to track the changes to the wetlands was 
devised through the use of a NWI key and parent key (see Figure 4) A photo interpretation key and 
the existing NWI data will be used to assist the interpreter in determining the wetland condition and 
class.  
 
Any wetlands that were either missed by the original NWI or have been created will be digitized 
and attributed. All existing wetlands that do not spatially register with the digital orthophotos will 
be modified to match the photo. “New” and modified wetlands will be classified to the class level of 
the NWI classification scheme according to the USFWS NWI Photointerpretation Convention. The 
water regime will be attributed to the best of the interpreter’s ability and the special modifiers will 
be attributed when necessary. When the interpretation is possible at the subclass level, they will also 
be included.  
 
If there is confusion as to the wetland type or condition during the photo interpretation process, they 
will be flagged for field verification in the database. A map of the flagged wetlands will be 
produced and sent to cooperators or DU field staff for field verification. Once field verified, the 
attributes will be updated and the verification process will be noted. 
 
The first step in the NWI updating process is to receive a copy of the USGS NWI Master 
Geodatabase (MGD) and import the database into DU’s Geodatabase (DU MGD) (see Figure 5 for 
an overview of the NWI process). The photo interpreters will be updating the NWI on a county-
wide basis, therefore, the second step is to have the photo interpreters “check out” a version of the 
MGD for their county to perform the update. Once the update is completed for their county, the 
third step is to run a QA/QC process to verify the attributes and spatial integrity. The fourth step is 
to perform the field verification and circulate the draft update for comments from cooperators.  The 
fifth step is to post the version back to the DU MGD. The final step is to return the updated NWI to 
the USGS MGD. For a more detailed discussion on the geodatabase (DU MGD) and update 
process, please refer to the “Data Management” and “Update Procedures” documentation. 
 
Following Figure 5 there is a procedural checklist that lists the steps for the NWI update.  The 
remaining chapters will document the process for completing these steps. 
 
 
 



NWI Key/Parent Key Example
Time 3Time 2Time 1

WET_POLY
OBJECTID
ATTRIBUTE PUB
NWI_KEY 101
PARENT_KEY
STATUS A
DRAINAGE_TYPE
PARTIAL
IMAGE_DATE 1978
FIELD_VERIFIED
COMMENTS
UPDATE_OPERATOR
UPDATE_DATE

WET_POLY
OBJECTID
ATTRIBUTE PUB
NWI_KEY 103
PARENT_KEY 102
STATUS A
DRAINAGE_TYPE D
PARTIAL Y
IMAGE_DATE 2005
FIELD_VERIFIED Y
COMMENTS
UPDATE_OPERATOR RDM
UPDATE_DATE 2007

WET_POLY
OBJECTID
ATTRIBUTE PEM
NWI_KEY 104
PARENT_KEY 102
STATUS A
DRAINAGE_TYPE
PARTIAL Y
IMAGE_DATE 2005
FIELD_VERIFIED N
COMMENTS
UPDATE_OPERATOR RDM
UPDATE_DATE 2007

Status becomes 
inactive (I) if there 
is a change in future
updates

A new polygon is created 
that can be linked back
to original data through 
the Parent_Key

If a polygon needs to be
split, both of the new polygons
can be linked back to the original 
data through the Parent_Key

WET_POLY
OBJECTID
ATTRIBUTE PEM
NWI_KEY 102
PARENT_KEY 101
STATUS A
DRAINAGE_TYPE
PARTIAL
IMAGE_DATE 1998
FIELD_VERIFIED
COMMENTS
UPDATE_OPERATOR RDM
UPDATE_DATE 2005

NWI Key = 101 NWI Key = 102
Parent Key = 101

Open 
Water

Emergent

Emergent

Converted

NWI Key = 103
Parent Key = 102

NWI Key = 102
Parent Key = 101
Status = inactive
Conversion = A
Partial = Yes

  
Figure 4: Wetland tracking over time.
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Figure 5. The NWI update process. 
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NWI Update Procedural Checklist 
 
 

CHECK OUT PROCESS 
  
 

  1) PI(1) checks out county from DU NWI Geodatabase 
 

  2) PI(1) updates NWI status layer for county (Status = “In Progress”) 
 
 

UPDATE PROCESS 
 

  3) PI(1) performs update on county 
 

  4) PI(1) runs QA/QC tests 
 

  5) PI(2) visually checks 10% of grids in county 
 

  6) PI(1) submits county to Analyst for QA/QC 
 

  7) Analyst performs QA/QC and checks in data 
 

  8) Analyst updates NWI status layer for county (Status = “Complete”) 
 

  9) DBA post draft data on web site 
 

FIELD VERIFICATION PROCESS 
 

  10) PI(1) updates NWI status layer (Verified -= “In Progress”)  
 

  11) PI(1) runs field selection process  
 

  12) PI(1) produces field maps 
 

  13) MAN enter maps into database  
 

  14) MAN sends maps to cooperators  
 

  15) PI(1) organizes field data and adds field data to the point file  
 

  16) PI(1) updates assessment table with field results  
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  17) PI(1) verifies field data and update/correct NWI layer 
 

  18) PI(1) submits verified county to Analyst for final QA/QC 
 

  19) Analyst performs QA/QC  
 

  20) Analyst updates NWI status layer (Verified -= “Complete”) 
 
 

INTREGRATION BACK INTO FWS NWI 
 

  21) Analyst prepares data to be sent to FWS 
 

  22) Analyst performs final QA/QC  
 

  23) Analyst creates metadata  
 

  24) Analyst sends data to the FWS  
 

  25) Analyst updates NWI status layer (Status = “Final”)  
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Chapter 5 – Check-Out Process 
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Create the Data Repository 
1. Launch ArcCatalog and create a personal geodatabase to hold your edits. Store the 

geodatabase in D:\Working and use the naming convention County_ST. 
 

Add Data to ArcMap 
1. Launch ArcMap  
2. Add data from database connection (Database Connections > Vector > NWI)  
3. Add feature datasset vector.GLAROGIS.NWI. This will include the WET_POLY feature 

class, as well as a county layer and a reference grid.  
4. To symbolize, right-click on layer and select 'Properties'. Click on the 'Symbology' tab. 

Symbolize active and inactive features as desired.  
5. Add imagery and other pertinent data (hydric soils, topographic map, etc) 

Check Out Data for Edits 
ArcGIS manages data edits by multiple users by implementing "versions" of data layers. Rather 
than making edits directly to the wet_poly layer, editing is performed on disconnected versions of 
the data which are stored in personal geodatabase format. Each user creates and edits a copy, or 
version, of a feature class. Upon the completion of each county, the data administrator will 
reconcile edits and post them to the master data layer. The users then create another version, and the 
process begins again.  
 
Step 1 & 2 below can be skipped by using the CheckoutSelection tool.  This tool performs the 
selection process and you can skip to Step 3.  To add this tool to your tool bar, select Customize 
from the Tools pull down menu in ArcMap. 
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Then click on the “Add from file” button at the bottom of the form.  Navigate to V:\Installs\GIS 
Misc\NWI\CheckoutSelection and select the “CheckoutSelection.dll” file.  From the Comands box 
on the form you should see the text “CheckoutSelection”.  Drag and drop this onto your toolbar.  
When you click on this button on your toolbar, it will ask you for the state and county you would 
like to select.  You can then skip to step 3. 
 

 
 

1. Select the target county. 
2. Under Selection > Select by Location, select all features from the WET_POLY and 

NWI_RefGrid_2000m layers that intersect the selected features in NWI_County: 
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3. Click on the 'Check Out' tool on the Disconnected Editing toolbar: 

 
 

4. Indicate the geodatabase as the output location. Name the check-out with the name of the 
county and state. Leave all other parameters unchanged and click 'Next': 

 
 
 

5. On the second window, check 'Change the layers and tables to point to the checked out data'. 
Click 'Finish': 
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Now, all edits will be made to the new version of WET_POLY. 
6. Save the map document (.mxd) file. 

 

Update NWI Status Layer 
 
In order to keep our cooperators informed of the status of the NWI update project, we have created 
a web page with a ArcServer application to identify which counties we are currently working on 
and which ones are completed.  The ArcServer application uses the NWI Status layer within our 
Geodatabase to create the map.  Once you check out a county for the updating process, you will 
need to update the NWI Status layer for that county. 
 

1. Add the NWI Status layer to ArcMap Database Connection > Vector > NWI Other > Status 
2. Start Editing 
3. Select County and change the status to “In Progress” 
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Status Layer Definitions 
 
Status 

In Progress - County has been checked out and the update is currently taking place 
Complete -   County has been QA/QC’ed and checked back into the geodatabase  
Final - Sent to the US FWS for inclusion in the NWI MGD 

 
Verified 

In Progress - Wetlands have been selected for field verification and maps have been sent to 
cooperators 

Complete -  Field verified wetlands have been checked, point file has been created, 
wetlands have been updated, data has been checked back into the 
geodatabase. 
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Chapter 6 - Update Process 
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County Updates 
 
The NWI update will be performed on a county by county basis.  Preferably no two counties will be 
checked out at the same time due to overlapping wetland polygons. 

Reference Grid 
 
A square mile reference grid was created to track the progress of the NWI update through the 
county.  The grid size was created so that one grid would be viewable at 1:10,000 on the monitor.  
Once the analyst completes the grid, a graphic is placed in the grid cell to identify its completion.  
The grid allows the analyst to keep track of the progress and aids in quality control. 
 

 
 

Creating a New Feature 
 
Interpretation 
The first step in creating a new wetland feature is to identify an unidentified wetland in the aerial 
photography. In this early spring color infrared image, there is dark area in an agricultural field. 
This area has different coloring and texture than the surrounding farm field. Also, it does not have 
plow lines going through it, suggesting that it is too wet to be farmed.  
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The same area is shown in a summer true color image. This is a good example of an emergent 
wetland. 
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Digitize the Feature 
1. To digitize this area, click on ‘Start Editing’ in the Editor drop-down box on the Editor 

Toolbar.  
2. Make sure the Task is set to ‘Create New Feature’ and the Target layer is set to 

‘WET_POLY:ACTIVE’. 
3. Using the Sketch tool, digitize the area around the feature.  

 
Update the Attributes 

4. Open the attribute window either by right-clicking on the polygon and selecting 
‘Attributes…’ or by clicking on the Attributes button on the Editor toolbar. In the Attribute 
window that opens, input an appropriate habitat classification value either by selecting the 
code from the drop down box or by typing it in. The feature in the example has been coded 
as Palustrine Emergent, which has a code of PEM. Please refer to the Photo Interpretation 
Guide for determining which NWI code to call the wetland. 

5. Note that by default, all newly digitized features will be assigned an NWI Key and will be 
given a Status of ‘Active’. 
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Modifying a Feature (Full) 
 
Interpretation 
In the lower left corner of the following image, the PUBGx polygon is too small for the current size 
of the excavated wetland. In this situation, we must replace the existing polygon with a new, larger 
one that properly represents the current state of the wetland. The original feature will be assigned a 
Partial value of ‘No’ and no conversion type indicating that the wetland was modified either 
spatially or a change in class (emergent to shrub). This change will most often occur with a change 
in the NWI code (see next example). 
 
Inactivate the Old Feature 

1. Select the polygon and open 
the Attribute window. Make 
the following changes: 
• Status = Inactive 
• Conversion_Type = Null 
• Partial = NO 

2. Copy the NWI Key to the 
clipboard. 

 
 
 
 
Create the New Feature 

3. On the Editor toolbar, set the task to ‘Create New Feature’. 
4. Using the Sketch tool, draw a new polygon around the wetland area. 
5. Paste the copied NWI Key from the inactivated polygon into the Parent Key field of the new 

polygon. This indicates that 
the new wetland feature was 
created out of the loss of the 
old. 

6. Enter the habitat 
classification for the new 
feature in the Attribute field. 
In the example, the new 
wetland has been classified 
as a Palustrine 
Unconsolidated Bottom, 
Permanently Flooded and 
Excavated, indicated by a 
code of PUBHx. 
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In the following example, the selected polygon was labeled PFOY.  From the Spring CIR imagery 
and the summer natural color imagery you can see the tree shadows from the surrounding forest in 
the SE portion of the selected polygon.  This indicates that the polygon is probably not a forested 
class and should be labeled as a shrub class.  This polygon will be copy and pasted with the original 
PFOY polygon inactivated with no conversion type and partial equal to “No”.  The new polygon 
will be labeled as PSS1B with the parent key copied from the NWI Key of the PFOY polygon. 
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Modifying a Feature (Partial) 
Interpretation 
In the image to the right, a PFO/SS1C polygon is 
partially overlapping a newly excavated area. In this 
case, the original wetland has partially changed its 
form. The original feature will be inactivated and will 
be assigned a Partial value of ‘Yes’, indicating that 
the existing wetland evolved from the old. 
 
Inactivate the Old Feature 

1. Select the polygon, copy the NWI Key, open 
the attribute table and make the following 
changes: 
• Status = Inactive 
• Conversion_Type = NULL 
• Partial = YES 

2. Copy the NWI Key to the clipboard. 
 
 
 
 
 
Create the New Feature 

3. On the Editor toolbar, set the task to ‘Create 
New Feature’. 

4. Digitize the area around the new, wetland. 
5. In the Attribute window, paste the NWI key from the previous polygon into the new 

polygon’s Parent 
Key field. 

6. Enter the habitat 
classification for the 
new feature in the 
Attribute field. In the 
example, the new 
wetland has been 
classified as a 
Palustrine 
Unconsolidated 
Bottom, Permanently 
Flooded and 
Excavated, indicated 
by a code of PUBHx. 
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Converting a Feature (Full) 
Interpretation 
A fully converted polygon is a wetland that no longer has evidence of existence. These polygons 
have been altered due to Agriculture, Development or Recreation. In cases in which none of these 

reasons apply, a feature can be assigned a 
Conversion Type of Other.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Inactivate the Feature 

1. Select the converted polygon and open the 
Attribute Table  
2. Change the following Attributes: 

• Status = Inactive 
• Conversion_Type = Agriculture 
• Partial = NO  
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Converting a Feature (Partial) 
Interpretation 
The wetland represented by the 
polygon in the following image 
has been partially converted to 
agricultural use. The polygon 
needs to be altered to indicate that 
the only remaining active portion 
lies within the forested area. 
 
 
 
 
 
 
 
 
 
 
 
 
Copy the Feature 

1. Select the PSS1/EMB polygon and copy it to the clipboard. 
2. Paste the copied feature into the view. This results in a copy of the original polygon in the 

same place as the original. The original polygon is automatically inactivated. The new 
feature is assigned a parent key of the old feature, and is selected for further editing. 

Reshape the New Feature 
3. On the Editor toolbar, set 

the task to ‘Cut Polygon 
Features’. Cut the copied 
polygon along the 
boundary of the current 
and former wetland. In 
the example, the feature 
is cut along the treeline. 
Be sure to begin and end 
the cut outside of the 
polygon. 
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Complete Conversion 
4. After completing the cut operation, 

three polygons remain: the original 
polygon and two new polygons. 
Select the original polygon and 
make certain the Status = Inactive. 
Set the appropriate 
Conversion_Type, and set the 
Partial = Yes. 

5. Select the new polygon which 
represents the current wetland 
extent. Confirm that the Parent 
Key of this new, active polygon 
matches the NWI Key from the 
original, inactive) polygon. 

6. Delete the remnant polygon, 
representing the converted area. 
This leaves two remaining 
features: the original, inactive 
polygon and the new, active one. 
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Correcting a Feature 
Interpretation 
Due to digitizing or georeferencing error, some polygon features do not accurately represent the 
wetlands from which they were created. If a polygon is clearly meant to cover a wetland area which 
it currently does not, the polygon should be shifted or otherwise edited to accurately represent the 
corresponding wetland. In such cases, it is interpreted that the original feature is being corrected. 
Therefore, no attribute changes shall be made. 
 
Shifting the Feature 

1. Click on the polygon to highlight it. 
2. Drag the polygon over the wetland. 

 

   
 
 Correcting the Feature 

1. Double-click on the polygon within it to view its vertices. 
2. Holding the cursor over a vertex will produce a diamond shape around the vertex. When this 

appears, one can safely move the vertex without shifting the entire polygon. Continue 
moving vertices until the polygon accurately portrays the wetland. 

 
(Sometimes using the “reshape feature” task is faster and easier then moving the vertex.) 
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Changing the Habitat Classification 
Interpretation 
Sometimes, wetlands evolve from one type to another. In such cases, the Attribute value must be 
changed to indicate an alteration from one habitat classification to another. In the 2003 summer 
imagery shown below, there is a polygon labeled PFO5F, indicating Palustrine Forested, Dead, 
Semipermanently Flooded. 
 

 
 
In the 2005 spring infrared image shown below, we see that the same farm is now being developed. 
The wetland area is still there, but the trees have been removed, so the Forested designation no 
longer applies. 
 

 
 
Copy the Feature 

1. Select the polygon, then Copy and Paste it. This action will set the Status = Inactive for the 
original. Manually set the following values: 
• Conversion_Type = NULL  
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• Partial = NO.  
2. Copy the NWI Key from the original feature and paste it into the Parent Key field for the 

new polygon. 
 
Update the Habitat Classification 

3. Change the Attribute to a more appropriate value. In the example, the feature is defined as a 
Palustrine Unconsolidated Bottom, Intermittently Flooded, Excavated, orPUBGx.  

4. The resulting image shows both Attribute values labeled over the wetland area, as well as 
the orange hashes indicating the inactive parcel. The copied polygon is still active. 
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Using the attribute transfer tool 
 
The Attribute Transfer Tool is useful in situations in which a polygon is attributed correctly, but is 
spatially incorrect. Here is a PUBG polygon that has expanded in the aerial imagery. This wetland 
must be digitized again to show its correct boundary, as well as the attributes will have to be 
transferred as this polygon will replace the incorrectly-sized polygon. 
 

 
 
 

1. Create a new polygon outlining the correct boundary of the wetland. 
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2. Open the Attribute Transfer Mapping toolbox. In the toolbox, select WET_POLY for the both the 
Source layer and the Target layer. Then click on the “Auto Match’ button (but DO NOT check the 
Transfer Geometry) and click OK. This step will only need to be done once for each county being 
worked on. 
 

 
 
 
 
3. Deselect both polygons and then click on the Attribute Transfer tool. Click within the boundary 
of the original polygon (if both polygons overlap, then the “Select a Source Feature” box will 
appear. Select the original polygon from the list and click OK). Next, click within the boundary of 
the new polygon. 
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4. Select both polygons to verify that the Attribute Transfer tool worked properly. If it did, then 
delete the original polygon. 

 
 
 
Here is what the image will look like when this task is completed. 
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Special Rules and Considerations 
 

1. If a polygon is determined to be fully converted, it can only be a parent to another wetland if 
there is a specified Conversion Type. Otherwise, its NWI Key is never copied and pasted 
into a new wetland. 

2. Wetland features with invalid habitat classification attributes can be corrected without 
further edits being made. 

 

Backups 
 
Ducks Unlimited does not back up individual computers.  It is the responsibility of the analysts to 
create a zip file of the personal database and map document on at least a daily basis and copy the 
zip file to the network drive (W:\GreatLakes_NWI_Update\Data Backup). 
 
 
 
 

QAQC Procedures 
Once the photo interpreter has completed the NWI update for a county, the version will undergo 
quality assurance/quality control (QA/QC) before the database administrator posts the version to the 
DU MGD. The first QA/QC process involves two steps. The first is to run DU’s 17-step attribute 
verification tool that checks for any errors in the additional attributes that were added by DU. The 
second step is a topology validation in which it is confirmed that no active features overlap and no 
inactive features overlap. The second step in the QA/QC process is for a different interpreter to 
visually verify 10% of the county. The third step is to run the USGS NWI attribute and verification 
tool (created through a cooperative effort between the U.S. Fish and Wildlife Service and the U.S. 
Geological Survey) to check for NWI attribute errors and spatial errors. The counties must pass the 
USGS attribute and verification tool in order for the USGS to accept the update back into the USGS 
MDG. (For more information on the USGS NWI attribute and verification tool, see 
http://capp.water.usgs.gov/FWS_web/tools.htm.) Once the version has completed the QA/QC 
process, it will be posted to the DU MGD by the database administrator. This posting process will 
update DU’s Master NWI geodatabase and effectively make any and all edits permanent. 
 
During the QA/QC procedure, geodatabases are stored at 
W:\NWI_Update\GreatLakes_NWI_Update\Finished Geodatabases, and status is tracked via the 
QAQC Status.xls spreadsheet that is located in that directory. 

Self Validation 
DU NWI QA/QC Validations 
The data editor runs 17 data validations on the wet_poly dataset as a first step in the QA/QC 
process. As previously discussed, the validations were designed by GLARO to assure adherence to 
logical and technical rules for the dataset. The validations are listed below: 
 

Test 1: If a feature is inactive and was created prior to 1998, it shouldn't have parent key.  
Test 2: The parent key should not equal the nwi key for a single feature. 
Test 3: The nwi key cannot be duplicated. 
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Test 4: Active features should not have drainage types or partial values. 
Test 5: If there is a drainage type, partial should be attributed. 
Test 6: If a feature is fully drained, it cannot be a parent to another feature. 
Test 7: If partial equals yes and drainage type is null, the parent and child objects must have 

different attributes. 
Test 8: Inactive date cannot be earlier than or equal to image date, or be null, on inactive 

features. 
Test 9: If partial equals yes, a feature should be the parent key to an active feature. If partial 

equals no and drainage type is null, a feature should be the parent key to an active 
feature. 

Test 10: If a features is inactive, partial must be attributed. 
Test 11: All features should be active or inactive. 
Test 12: All features should have an attribute value. 
Test 13: A feature's parent key should always be the nwi key on an inactive polygon. 
Test 14: The attribute must be valid on active features. 
Test 15: Image Date must not be null or 0, and cannot be greater than 1997 for original features 

(with few exceptions). 
Test 16: Active features cannot have inactive dates. 
Test 17: The inactive date on a parent feature cannot be greater than the image date on its child. 

 
First, the operator that worked the county will run a set of tests via ArcToolbox. To install the NWI 
QAQC Toolbox, follow these steps: 
 

1. Open ArcMap, show the ArcToolbox window by clicking on the icon:   
2. Right-click on the ‘ArcToolbox’ header and select ‘Add Toolbox’. 
3. Navigate to V:\Installs\GIS Misc\NWI\QAQC Toolbox, select ‘NWI QAQC Tools’, and 

click ‘Open’. This adds the toolbox to your map document. 
4. Right-click on the ‘ArcToolbox’ header again and select Save Settings > To Default. Now, 

every time you open ArcToolbox, the NWI QAQC Toolbox will be included. 
 
To use the toolbox, you first need to set up your data validation environment. Add the wet_poly 
feature class to be validated as well as any relevant imagery and other data. Begin an edit session 
before running the validation script. 
 
The validation script can be run two different ways. First, it is executed by double-clicking on the 
NWI Validations script in the NWI QAQC Toolbox. Select the wet_poly feature class and the 
appropriate test.  
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Second, it can be run via the command line. Show the command line window by clicking on the 
appropriate icon:  Run the test by typing “NWI_Validations” followed by the input feature class 
and the test. For example: NWI_Validations WET_POLY 'Test 1' 
 
Run the tests in order, being sure to select the wet_poly feature class from the list of layers in your 
map document (A) rather than navigating to the feature class (B).  
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A) Selecting the wet_poly feature class from the list of layers in the map document. 

 
B) Selecting the wet_poly feature class by navigating to its location on disk. 
 
Each test selects features that fail, but does not automatically refresh the view. To see if any features 
were selected, click on the ‘Selection’ tab in the Table of Contents to see how many features in 
wet_poly are selected: 

 
 
To view selected features, refresh the view, or use the attribute inspector to zoom to each. The 
attribute inspector will automatically list all selected features in its left window pane. You can zoom 
to each by right-clicking on the feature label and selecting ‘Zoom To’: 
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Further detail on each test is included in the Help for the NWI Validations script. Access the help by 
right-clicking on the script and selecting ‘Help’, or by clicking on the Help button on the script 
dialog window. 
 
Topology 
Additionally, no active features should overlap active features and no inactive feature should 
overlap inactive features. To validate topology, a topology rule must be created in the personal 
geodatabase. Active and inactive overlaps must be tested separately. 
 

1. Open ArcCatalog, navigate to the personal geodatabase and select the NWI feature dataset. 
2. Right-click and select New > Topology. 
3. Accept the default name and cluster tolerance. 
4. Select the wet_poly feature class to participate in the topology. 
5. Accept the default rank. 
6. Add the rule that active features must not overlap one another. To select active features only, 

drop down the feature class combo box and expand the wet_poly feature class. 
7. Finish the wizard and validate the entire topology. 

 
To view and edit topology errors: 

8. Open ArcMap. Add the topology rule and associated feature class. 
9. Add the Topology toolbar to the map document. 
10. Start editing the wet_poly personal geodatabase feature class 
11. Use the error inspector and topology validation tools to correct and track errors. 

 
Once complete, the topology rule must be changed to validate inactive rather than active features. 
To do so, close out of ArcMap and return to ArcCatalog. Edit the topology created earlier, removing 
the previous rule and replacing it with one for inactive features. Validate and correct errors as 
before. 
 

Cross Validation 
A different data editor is asked to review 10% of the completed counties updates as the second stage 
in the QA/QC process. This is done by randomly selecting 10% of the 2000 meter grid cells that 
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intersect the county. Do so by adding the NWI_RefGrid_2000m feature class from the personal 
geodatabase. Manually select 10 percent of the grid features, and export to a ‘QAQC’ feature class 
in the same geodatabase. (This preserves a record of the area that was checked.) Visually inspect all 
selected grid cells. If the reviewing editor finds an unacceptable amount of errors, the county is sent 
back to the original editor for revision and the QA/QC process begins anew. 
 

Administrator Validation 
As the third and final step in the QA/QC process, a data administrator reviews the county’s NWI 
update. The data is spot checked at the beginning of the process and visual inspections continue 
throughout the final stage of QA/QC. After the initial spot check, the FWS’ attribute validation tool 
is run. Once any errors found by the FWS’ tool are corrected, DU’s 16 validations are rerun. If any 
errors are found, they are corrected. All of the steps are repeated until both sets of validations find 
no errors. The final step is to revalidate topology. 
 

Checking In Data 
 
Upon completion of QA/QC process for each county, the data must be checked back into the 
database. 
 

Check In Edits 
 

1.  Open ArcMap, add the wet_poly personal geodatabase feature class. 
2.  Click ‘Check In’ on the Disconnected Editing toolbar. Leave ‘Reconcile and Post with 

parent version’ unchecked and click ‘Finish’. Access the SDE feature class as the user which 
checked out the edits. Connect to the version that is checked out (Although any version can 
be used at this point, it will be important in the next step that you connect to the checked-out 
version, so it is best to establish that connection now.) This will allow ArcMap to unregister 
the checkout after checking in the data.  

 

Reconcile and Post Edits 
 

3. Add the wet_poly feature class from the SDE database. Connect as the user that checked out 
the edits to the version that is being checked in. 

4. Start editing the SDE workspace. 
5. Click on the ‘Reconcile’ button on the Versioning toolbar. 
6. Reconcile against the sde.DEFAULT version. 
7. Click on the ‘Post’ button on the Versioning toolbar to post the edits to the sde.DEFAULT 

version. 
 

Update NWI Status layer  
 
Once the update NWI county is reconciled and posted to the SDE databse, the Analyst updates the 
NWI status layer for that county to “Complete”.  This information then gets posted to the web site 
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for the cooperators to view.  At this stage the county has been updated, but still needs to go through 
the field verification step in order to be “Final”. 
 

Post Completed Counties on Web Site 
 
The completed counties will be posted on the DU NWI web site in shapefile format.  This allows 
the cooperators to use the draft data and provide feedback before the update is finalized. 
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Chapter 7 - Field Verification and Assessment 
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The field verification will serve two purposes: 1) to help clarify any wetlands that are ambiguous in 
the photo-interpretation process, and 2) to access the accuracy of the NWI update. Field staff from 
project cooperators and DU will be used for this process as available.  
 

Ambiguous Wetlands 
 
During the interpretation process, there will be some wetlands that can’t be positively identified by 
wetland type or determine if it still exists from the digital orthophotography. In these cases, the 
wetlands will be flagged in the NWI geodatabase and a map will be made for field inspection. The 
maps will be sent to the field staff for field inspection to determine their wetland type and status. 
Once determined, the NWI geodatabase will be updated with the field verification information and 
noted in the attributes that the wetland was field verified. 

NWI Assessment 
 
The NWI assessment will primarily be an assessment of the wetland status and class. It will not be 
an assessment of the full NWI classification scheme (subclass and modifier level). Funding to 
perform a full accuracy assessment of the wetland types is cost prohibitive for this project. The goal 
of the field assessment is to sample 1% of the wetlands per county and assessing the status and 
wetland class through a simple field card and digital photo. DU does not have enough field staff to 
visit all of the sites, so a database of field staff from DU cooperators and volunteers for the Great 
Lakes will be generated that includes the geographic area each field staff is willing to visit. Once 
the field samples are selected, they will be sent to the field staff in the representative areas for field 
verification. 
 
The 1% sample will be stratified based on wetland class and status. Only wetlands close to roads or 
on public land will be chosen. Once the samples are generated, a field inspection will be conducted 
by driving to each site, recording the wetland type, and taking a digital photo of the wetland. The 
methods for the field inspection will be patterned off of Ohio NRCS’s field inspection of wetlands 
in 2006. The resulting field data and photo will be entered into the DU MGD. An error matrix and 
Kappa statistic (Story and Congalton, 1986) will then be compiled and analyzed by comparing the 
photo interpretation to the field conditions.  
 

Field Verification Goal 
 
Following updates to the National Wetlands Inventory (NWI), Ducks Unlimited’s Great 
Lakes/Atlantic Regional Office (GLARO) will conduct an accuracy assessment of the inventory’s 
wetland classifications.  The assessment will (1) evaluate the accuracy of classifications assigned to 
wetlands original to the NWI, (2) evaluate the accuracy of classifications assigned to wetlands new 
to the NWI and (3) evaluate the accuracy of wetlands identified as converted.  1% of wetlands 
within the updated NWI will be field verified. 
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Field Verification Process 
Participants 
GLARO will contact cooperating partners and volunteers to identify those willing to assist GLARO 
in field verification.  Typically, participants will be familiar with wetland classifications.  GLARO 
will then match participants with wetlands within areas that they may conveniently visit. 

Field Verification Materials 
Each participant will be provided with: a set of directions, maps of the wetlands to be field verified, 
and a photographic guide to wetland classification.  GLARO will also provide disposable digital 
cameras to participants who require them. 

What is asked of participants? 
Participants will be instructed through provided directions to visually inspect each wetland, assign a 
wetland classification and then take a photograph.  The participants will then be instructed to return 
all field verification materials to GLARO. 
 

Wetland Selections 
Percentage Goal 
GLARO intends for 1% of all wetlands within a county to be field verified.  As a variety of 
problems may prevent the successful verification of a wetland, a surplus of wetland selections will 
ensure that this goal is met.  2% of wetlands will therefore be selected for field verification.  The 
entirety of this 2% selection will be given to project participants with the intention of at least 1% 
visited in the field. 

Grouped Selections 
As previously stated, this assessment intends to (1) evaluate the accuracy of classifications assigned 
to wetlands original to the NWI, (2) evaluate the accuracy of classifications assigned to wetlands 
new to the NWI and (3) evaluate the accuracy of wetlands identified as converted.  Wetlands, 
therefore, will be separated into three groups to select wetlands for field verification.  The groups 
are: 

  
1. Wetlands original to the NWI.  This includes wetlands unaltered by updates and also 

wetlands that had been included in the original NWI that have been modified. 
 

2. Wetlands new to the NWI.  This includes only wetlands not associated with any wetland 
included in the original NWI. 

 
3. Wetlands identified by the updated NWI as converted. 

 

Class Selections 
To ensure that wetlands selected for field verification are representative of the actual population of 
wetlands, wetlands will be selected from the above groups stratified by classification type.  To 
clarify, within each group of wetlands, subgroups designated by classification type will be identified 
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and then selections made from each subgroup.   Note, however, that the assessment will recognize 
only differences in classification according to class level, not subclass or modifiers. 
 

Limited Selection 
The assessment recognizes that it is not realistic to expect, or even request permission to inspect 
wetlands on private property.  To accommodate this restriction, only wetlands within 90 meters of a 
roadway (approximately the distance of one football field) will be selected for verification. 
 

NWI Status Layer 
 
Before the analyst begins the wetland selection process, the “verified” attribute is changed to “In 
Progress” in the NWI status layer.  This allows the manager and staff to identify which counties 
have started the wetland selection process for field verification. 
 

 

Wetland Selection Methodology 
 
To select wetlands according to the above specifications, a GIS-based methodology has been 
developed.  This process is performed on a per-county basis.  The methodology is outlined below: 

 
1. Navigate to the Field Verification Tool installation package located at V:\Installs\GIS 

Misc\NWI\Field Verification Selection\Package\setup.exe.  Complete the installation 
process.  This step only needs to be done once so if you have already completed the 
installation please move on to step 2.  

2. If one does not already exist, create a folder in your D:\Working folder named ‘Field 
Verification’ 

3. In ArcCatalog, create a new personal geodatabase in your Field Verification folder 
named Countyname_Stateabbreviation_FV (i.e.  Huron_OH_FV).   

4. In that new PGD, create a new polygon featureclass named FIELD_VERIFICATION.  
Import the coordinate system and the schema from the SDE WET_POLY layer.   
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5. Open arcMap and add the SDE WET_POLY and NWI_COUNTY layers to the new map 
document.  

6. If you have already installed the FVSelect.dll, please continue to step 7. Otherwise, 
Navigate to Tools > Customize > Commands > Add from File and add the FVSelect.dll 
from the folder C:\Program Files\FVSelect.  

7.  Navigate to the NWI category in the Categories Window and from the Commands 
window drag both the ‘Select NWI’ and ‘Field Verification Selection’ buttons to the 
toolbar. 

8. Click on the ‘Select NWI’ button and choose the state and county of interest, then click 
on the ‘Select’ button.     

9. Extract (do not check out) the selected features to your County’s PGD and choose to 
change the layers and table to point to the extracted data.  

10. Add the SDE GrtLks_All_Roads layer to the map document.  Select by location all roads 
intersecting your county and export as a feature class in the same projection as the data 
frame into your County’s PGD. This feature class should be named ‘GrtLks_All_Roads’.  
Add to map document.  Remove the SDE GrtLks_All_Roads layer from the map 
document.   

11. Add the Vector.GLAROGIS.PARENT TABLE from the vector database on SDE to the 
map document as well as the new FIELD_VERIFICATION layer from your PGD.  

12. Make sure the following are true: 
a. These feature classes must be present and  have these specific names in the TOC: 

i. WET_POLY 
ii. GrtLks_All_Roads 

iii. NWI_COUNTY 
iv. FIELD_VERIFICATION 

b. The parent table must be in the map document and must be the only table in the 
map document 

c. There must not be any raster layers in the map document  
13. Begin an edit session with the FIELD_VERIFICATION layer as the current editable 

layer. 
14. Click the ‘Field Verification Selection’ button to start the selection process. 
15. Once the selection is completed, save edits and stop editing session. 
16. Backup your County’s PGD to the appropriates State’s folder in  

W:\GreatLakes_NWI_Update\Field_Verify 
 

Creating Field Verification Maps 
 

Create Overview Map of County 
 

1. Make sure before you begin that the MapBook is installed on your computer.  It will appear 
as a tab on the Table of Contents in ArcMap.  If not, navigate to V:\Installs\GIS 
Misc\extensions\DS_MapBook\DS Map Book v2 Edited\_install.bat to install a customized 
version of the extension.  

2. If you haven’t already, copy the ‘Field_Verification_OverviewMapbook_Template.mxd’ 
and ‘Field_Verification_Mapbook_Template.mxd’ files from 
W:\GreatLakes_NWI_Update\Field_Verify  into your FIELD_VERIFICATION folder on 
your D:/ Drive.  

77 



3. Create a new polygon shapefile named “Overview Grid” saved to your D Drive that will be 
used to divide the County into 4 parts.  Add a text field named “Index”. This shapefile can 
be reused and is just for cartographic purposes so this step only needs to be done the first 
time you complete this process.   

4. Open ‘Field_Verification_OverviewMapbook_Template.mxd’ and view the data source 
properties for the FIELD_VERIFICATION featureclass.  Reset the source to the 
FIELD_VERIFICATION feature class for the County you are printing field maps for.  
Zoom to this layer.   

5. Symbolize the vector.GLAROGIS.NWI_County featureclass by the County of interest with 
a White background and All Other Values gray.   

6. Reset the data source to the Overview Grid shapefile that you created in step 3. Start an 
editing session on this shapefile and delete all features in the shapefile.  Create a square 
around the County of interest and then cut this square into 4 quadrants and fill in the text 
field you created for the shapefile with the number of the quadrant. 

7. Update Title with appropriate County name and placement.   
8. Print the map. 
9. Label the FIELD_VERIFICATION feature class by the NWI_KEY field.   
10. Click the ‘Map Book’ tab in the TOC and right-click ‘Map Series’ and delete series if one 

exists already.  Right-click ‘Map Book’ and choose ‘Add Map Series’. 
a. Set up the first screen like below. Click ‘Next’  
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b. Set up the second screen like below. Click ‘Next’ 

 
c. Set up the third screen like below. Click ‘Finish’ 

 
11.  There are now maps for each quadrant you created.  Double Click page 1 and change the 

title to “X County Page Y” and then print the page.  Do this for each page.   
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Create the Field Maps 
 
 

1. Open the Field_Verification_Mapbook_Template.mxd file. Edit the county and state in the 
top-right corner of the layout. 

Map Book Tab Local Identifier 

Full County View Wetlands View 

2. Update the TOC for the specific County 
a. Start with the ‘Full County View’ data frame.  Change the County symbology to 

your County of interest.  This County should be White while all other values are 
gray.  Pan the data frame so it can be seen on the map and tweak the scale so you can 
see the entire County.   

b. Change the ‘Scaled Local Identifier’ data frame next.  For the GrtLks_All_Roads 
feature class, set the data source to the GrtLks_All_Roads featureclass from your 
PGD for the County of interest.  Also for the vector.GLAROGIS.NWI_County 
feature class change the symbology to your County of interest with the same beige 
color and all other values gray. Note:  This data frame should stay at the scale 
1:120,000. 

c. Finally, change the Wetlands Features (1:6000) data frame.  For the 
GrtLks_All_Roads, FIELD_VERIFICATION, and NWI_County feature classes set 
the data sources to the data from your PGD for the county of interest following the 
same procedure seen in the above step.  Pan to your County.  Note:  This data frame 
should stay at the scale 1:6,000. 

d. In the top right corner of the map, change the name of the County to your County of 
interest.   
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3. Click the Map Book Tab in the TOC.  Right-click ‘Map Series’ and Delete Series if one 
exists.  Right-Click ‘Map Book’ and select ‘Add Map Series.’   

a. Set up first Screen just like the one below. Click ‘Next’ 

  
b. Set up the second screen just like the one below. Click ‘Next’ 

 

81 



c. Set up the third screen just like the one below.  Click ‘Finish’ 

 
 

d. The map book is now all set up and ready.  Double-click on page 1 
4. There are Extent Windows set up in the Full County View and Local Identifier Data Frames 

based on the Wetlands View (1:6000) data frame.  The one in the Full County View data 
frame will appear as a red dot somewhere in the County.  For the Local Identifier data 
frame, you will need to pan around the county to find the red square extent window.  Make 
sure to have this centered for each map.   

5. You will need to do these last 2 steps manually for each map.  
a. Note:  If there are more than 1 wetland in the Wetlands View (1:6000) data frame, 

create a callout graphic pointing to the wetland(s) that is not the primary focus of that 
map.   

b. Note:  Sometimes a wetland is too large to fit fully in the Wetlands View (1:6000) 
data frame at the 1:6000 scale.  If this is the case, right-click ‘Map Series’ and select 
‘Series Properties.  Change the Extent to Variable with a 5% margin and click 
‘Finish’.  You will have to refresh the current page you were working on for this to 
take effect.  Make sure however that after you are finished with that current page, to 
go back to the ‘Series Properties’ to change the extent back to Fixed at 1:6000.   

6. After the first map is complete right-click the page you are on and click ‘Print Page’.   
7. Double-click on the next map and follow steps 4-6 until you finish all maps.   

 

Field Verification 
 
Once the field verification maps are created they need to be sent to cooperators or visited by DU 
staff.  This project does not have a lot of time budgeted to perform the field verification; therefore 
most of the field verification will be performed by cooperators or volunteers.  

Cooperator Database 
 
In order to keep track of the cooperators and volunteers for the field verification, a database was 
created that keeps track of the name and address of the individuals along with the county and map 
numbers that were sent.  Once the field verification maps are created for a county, the cooperator 
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database is queried to determine the number of individuals available for field verification.  The 
maps are then split up between the individuals and sent along with instructions (Appendix D). The 
cooperator database is located at W:\GreatLakes_NWI_Update\Field_Verify\ Field Verification 
Contacts.mdb. 
 

 
 

Field Verification Assessment and Updates 
 
Once the field maps have been verified in the field and returned to Ducks Unlimited, they need to 
be entered into the NWI Photos geodatabase, compared to the updated NWI data, and make any 
corrections to the updated NWI. 

Check out NWI Data and Add Verification Layers 
 

1) In ArcCatalog, create a new Personal GeoDatabase on your working drive using the 
County_State_AA_date (ex: Jackson_MI_AA_06_20_08) naming convention. 

2) Follow the NWI check out procedures 
3) Add the NWI_Photos SDE layer in the NWI_Other GeoDatabase to your map document and 

change version. 
a. Click on Source tab on the bottom of the ArcMap Table of Contents 
b. Right Click on sde.Default (glaro_sde) and go to “change version” 
c. Change the version to “NWI_Photos” 
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4) Add NWI Field Verification table (Make sure this table is from the NWI_Phtotos version as 
well, if not, change it like in step 3. 

 

Add Field Verification Point and add attributes 
 
For pre-selected sites: 
 

1) Use the Find tool (Edit > Find), Features tab to find and zoom to the Wetland # of the pre-
selected site that was field verified. 

2) Start Editing the NWI_Photos layer and create a point that corresponds to the location of the 
photo drawn on the field verification map. 

3) Add attributes from field verification form to the attribute table. 
4) Add digital photo to the raster attribute, click on the attribute and navigate to the photo. 

 
For field selected sites: 
 

1) For field selected sites already in shapefile (OH NRCS), add the shapefile and “copy” and 
“paste” the points into the NWI_Photos layer.  Make sure all of the attributes are copied into 
the NWI_Photos Layer. 

2) For field selected sites without a shapefile, locate the location based on the Lat/long or 
intersections and aerial photos and add the point like in the pre-selected site. 

 

Update NWI Field Verification Table 
 

1) Add the county, state, NWI Key, NWI code (from the NWI polygon), Field code (from the 
field data sheet, and the preseleted field. 

2) Be sure to look at the field photo and double check that the NWI class from the field 
verification makes sense.  For the NWI codes, only go to the CLASS level (PUB, PEM, 
PAB, PFO, PSS, LUB), as we are not verifying the subclasses or modifiers. 

3) For the converted wetlands – Identify them in the Field Verification Table as: CA = 
Converted due to Agriculture, CD = Converted due to Development, CR = Converted 
due to Recreation, CO = Converted due to Other. 

 

Update the NWI data 
 

1) Update the NWI code in the NWI polygon layer if the class was different from the field 
verification. 

2) Update the NWI polygon shape if necessary 
3) Make sure to change the Field Verification attribute to “YES”. 

 

Final QA/QC and check into SDE 
 

1) Run the QA/QC process on the NWI county data and then send to Analyst to check back 
into the SDE layer. 

2) Change the NWI status layer to Finished. 
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3) Notify Blair to reconcile and post NWI Photos version (specifically mention NWI_Photos 
featureclass and FIELD_VERIFICATION table) to the default version. 

 

Create Accuracy Assessment Table 
 

1. Create an ODBC Connection to the SQL Server Database for your computer if not already 
created.  If one is already created, proceed to step 2. 

a. From the Control Panel, open Administrative Tools and then Data Sources (ODBC).   
b. The ODBC Data Source Administrator Window opens. On the System DSN tab and 

click ‘Add’ 
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c. Scroll down the list on the Create New Data Source Window and select SQL 
SERVER and click ‘Finish’ 

 
d. On Create a New Data Source to SQL Server screen, name the data source ‘vector’ 

and describe it as ‘vector’.  In the Server drop down menu, choose ‘GLARO_SDE’.  
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Click ‘Next’  

 
e. On the Microsoft SQL Server DSN Configuration screen, select the second radio 

button as seen below and make sure the ‘Connect to SQL Server…..’ box is checked.  
For Login ID enter your user name and for password enter your SDE Password. 
Note: This is different than your Windows authentication password you login to 
Windows with. Click ‘Next’ 
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f. Leave everything on the next screen the same and Click ‘Next’ 

   
 
g. Leave everything on the next screen the same and Click ‘Finish’ 
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h. Click ‘Test Data Source’ and if successful, Click ‘OK’.  If unsuccessful, go back and 
double check all settings are correct.  

 
 

2. If you have not done so already, copy the ‘Accuracy Assessment Matrix.rpt’ file from 
W:\GreatLakes_NWI_Update\Field_Verify onto your D Drive. This is a Crystal Reports file 
which requires that Crystal Reports be installed on your computer. If you have not already 
done so, install Crystal Reports for ESRI from the ArcGIS media. 

3. Open the ‘Accuracy Assessment Matrix.rpt’ file. If it is not already in the Preview mode, 
click on the ‘Preview’ tab on the left side of the window. 
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4. To view the data for a particular county, click on the Refresh button  on the toolbar.  If 
you are asked if you want to Refresh Report Data, select  ‘Prompt for new parameter values 
and click ‘OK’.  

       
 
5. Enter a state and county from the dialog and click ‘OK’. 
6. Before continuing, ensure that all wetlands have been properly classified. For the purposes 

of field verification, we are only classifying to the Class level, meaning that the only valid 
entries for NWI Code or Field Code in the field verification table are CA, CD, CR, PAB, 
PEM, PFO, PSS, PUB, and LUB. Any features that have an invalid NWI Code or Field 
Code will be tallied in red text as an ‘Incorrectly Classified Wetlands’ notation in the 
bottom-right corner of the report. Correct these entries are refresh the report. If the notation 
does not appear, all wetlands have been classified correctly.  

7. From the File menu, select Export > Export Report.  Select format ‘Adobe Acrobat (PDF)’ 
and click ‘OK’. 

8. Name the file “County_State_AATable_Date”  i.e.”Jackson_MI_AATable_06182008” and 
save in the appropriate State’s folder in W:\GreatLakes_NWI_Update\Field_Verify. 
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Chapter 8 – Integration with FWS NWI  
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This project will result in the creation of two NWI products. All products will be in Albers Equal 
Area projection as used by the FWS in the NWI MDG. The first product is the DU MGD that will 
be used to track the status of wetlands across Indiana. Since no additional attributes can be added to 
the FWS MGD, another product will be created that will be sent to the FWS for inclusion into the 
NWI MGD. Therefore, all additional fields in DU’s MGD will be removed before the layer is sent 
to the FWS. In order to accomplish this, another version of DU MGD will be created which will 
have all records of converted wetlands and DU added fields removed.  
 
 
Upon completion of a 1:100,000 USGS quad cell, the features within the cell are extracted and 
delivered to the FWS, where they are merged back into the master geodatabase. Active features 
only are returned to the FWS. 
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Chapter 9 - Reporting 
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The reporting for the NWI update is based on a state-wide analysis and county by county analysis 
using the full DU updated NWI dataset.  The dataset sent to the FWS for inclusion in the official 
NWI data can not be used for comparison between the original and updates NWI (see Chapter 8 for 
more details).  Both wetland numbers and wetland acres were determined and compared between 
the original NWI (1980-1988) and the updated NWI (2005).  The wetland numbers and acres were 
generated using the status, conversion type, image date and parent key.  This chapter will explain 
the process for calculating the number and acres using the additional attribute fields. 
 
It is important to note that wetlands identified in the update that were not in the original, are 
not necessarily newly created wetlands.  In many cases, the scale of the imagery used in the 
update (2005) was better than what was used in the original classification.  Therefore, many of 
the newly identified wetlands are small and would not necessarily have been seen in the 
original classification. 
 
Also note that summing the number of wetlands from the county analysis will not equal the 
state-wide number because the wetlands that overlap county boundaries will be double 
counted. 
 
 

Data Organization and Pre-processing 
 
Below are the data organization and pre-processing steps that need to be performed on the data 
before calculating the wetland numbers and acres.  Some of the layers below refer to data layer 
names specific to the Ducks Unlimited system, but you can substitute your own county layer or 
other boundary layer.  In summary, the below process extracts the wetlands for a given state from 
the Great Lakes NWI wetlands geodatabase and adds the Parent Key attribute to identify those 
wetland that were modified (changed class) from those that were converted. 
 

In ArcCatalog, create a new personal Geodatabase called “state_stats” – with “state” being 
the name of the state you are summarizing. 
 
Open ArcMap 
 
Add GLAROGIS.USA_County and GLAROGIS.WET_POLY layers 
 
Select by state name in the USA_County layer the state you want to summarize 
 
Select by location all WET_POLY that intersects the selected counties. 
 
Export the selected polygons to the state_stats personal geodatabase and name it 
“WET_POLY”. 
 
Add an attribute called “Parent” to the newly created “WET_POLY” layer (Text, 2) 
 
Add the PARENT Table 
 
Join the PARENT Table to the WET_POLY layer. 
 
Select by attribute in the WET_POLY layer where Parent_Key is not NULL 
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Calculate the Parent attribute = Y 
 
Switch selection 
 
Calculate the Parent Attribute = N 

 

Original Wetland Numbers and Acres 
 
In order to report wetland numbers from the original NWI classification, a selection of wetlands is 
performed where the “Image Date” is from the dates that the original classification was performed.  
The original dates can be determined from the FWS NWI metadata.  For the state of Indiana the 
original classification was performed from imagery between 1980 and 1988.  In summary, the 
below process selects the wetlands with an image date between 1980 and 1988, intersects it with the 
county layer and summarizes the number and acres of wetlands by county. 
 

Select from WET_POLY: 
 
Image Date < 1989 
 
Create layer file from selection 
 
Intersect selection with county, and name WET_POLY_Org_Cnty 
 
Re-calculate the Acres field 
 
Summarize by county name on Acres  
 

 

Current Wetland Numbers and Acres 
 
In order to report current wetland numbers from the NWI classification, a selection of wetlands is 
performed where the Status is Active (0).  In summary, the below process selects the wetlands that 
are active based on the most current imagery (2005 for Indiana), intersects it with the county layer 
and summarizes the number and acres of wetlands by county. 
 

Select from WET_POLY: 
 
Status = 0 
 
Create layer file from selection 
 
Intersect selection with county, and name WET_POLY_Act_Cnty 
 
Re-calculate the Acres field 
 
Summarize by county name on Acres  
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Fully Converted Wetland Numbers and Acres 
 
In order to report the wetland numbers that were fully converted (the entire wetland was converted), 
a selection of wetlands is performed where the “Status” is “1 - Inactive” and “Partial” is “N” (NO) 
and “Conversion Type” is not “Null”.  The selection is then intersected with the county layer and 
summarized to determine the number and acres of wetlands by county. 
 

 
Select from WET_POLY: 
 
Status = 1, Conversion type is not NULL, Partial = N 
 
Create layer file from selection. 
 
Intersect with county layer and name WET_POLY_Full_Cnty 
 
Re-calculate the Acres field 
 
Summarize on county by acres. 
 

 

Partially Converted Wetland Numbers and Acres 
 
In order to report the wetland numbers that were partially converted (only part of the wetland was 
converted), a selection of wetlands is performed where the “Status” is “1 - Inactive” and “Partial” is 
“Y” (Yes) and “Conversion Type” is not “Null”.  The selection is then intersected with the county 
layer and summarized to determine the number and acres of wetlands by county. 
 

Select from WET_POLY: 
 
Status = 1, Conversion type is not NULL, Partial = Y 
 
Create layer file from selection. 
 
Intersect with county layer and name WET_POLY_Part_Cnty 
 
Re-calculate the Acres field  
 
Select from WET_POLY: 
 
Status = 0 (Active) 
 
Create Layer file from selection (WET_POLY_Active) 
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Intersect WET_POLY_Part_Cnty with the WET_Poly active selection and name 
WET_POLY_Part_Act. 
 
Dissolve all polygons that have the same NWI Key  (Check to make sure you have the same 
number of polygons as are in the WET_POLY_Part_Cnty layer), name layer 
WET_POLY_Part_Dis. 
 
Caculate the acres for the Child Acres field (the second “acres” field). 
Create new field called “Part_Acres” 
 
Caculate Part_Acres as Acres – Acres_1 
 
This is the number of acres that were converted for the partial wetlands. 
 
Summarize on county by “Part_Acres”. 
 

Additional Wetland Numbers and Acres 
 
In order to report wetland numbers identified in the updated NWI and not in the original NWI 
(“new” wetlands), a selection of wetlands is performed where the “Status” is “0 - Active” and 
“Image Date” is greater than “2005” and “Parent Key” is “N”.    The selection is then intersected 
with the county layer and summarized to determine the number and acres of wetlands by county. 
 

Select from WET_POLY: 
 
Status = 0 and Image Date = 2005 and Parent Key = N 
 
Create layer file from selection. 
 
Intersect with county layer and name WET_POLY_Add_Cnty 
 
Re-calculate the Acres field 
 
Select Attribute for “PW”, “Pf” and “PEMAf” and switch selection 
 
Summarize on county by acres. 
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Chapter 10 - Results 
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The results reported in this document are for planning purposes only and are not intended for 
regulatory purposes.  Before using any of the reported results, the user should have a through 
understanding of the methods reported in the previous chapters.  Please see Appendix C for a 
list of wetland statistics by county. 
 
 

Wetland Conversion by Number and Acreage 
 
The total number of NWI wetlands (circa 1975-1990) that were fully or partially converted (circa 
2006-2007) was 26,739 (Table 1).  A majority of the wetlands converted were fully converted 
(20,943).  The total acreage of NWI wetlands (circa 1975-1990) that were fully or partially 
converted (circa 2006-2007) was 38,325.57 (Table 2).  The average size of the converted wetlands 
was 1.43 acres.  The majority of the converted wetlands were due to agricultural purposes (50%) 
with development being the second largest percentage (46%).  The geographic distribution of the 
wetland conversion is concentrated in the northeast and border counties in the northwest parts of the 
state (Figure 1).  The number of acres converted by county varied from 21 to 1,557 acres.   
 

Table 1.  The number of wetlands converted by conversion type (1975/90 to 2006/7) 
 

Number % Number % Number % Number % TOTAL

FULLY CONVERTED 11,641 55.58% 8,630 41.21% 236 1.13% 436 2.08% 20,943
PARTIALLY CONVERTED 1,852 31.95% 3,776 65.15% 122 2.10% 46 0.79% 5,796

TOTAL 13,493 50.46% 12,406 46.40% 358 1.34% 482 1.80% 26,739

AGRICULTURE DEVELOPMENT RECREATION OTHER

 
 
 
 

Table 2.  The acreage of wetlands converted by conversion type (1975/90 to 2006/7) 
 

Acres % Acres % Acres % Acres % TOTAL

FULLY CONVERTED 13,725.69 57.15% 9,579.49 39.88% 277.09 1.15% 436.24 1.82% 24,018.51
PARTIALLY CONVERTED 6,056.61 42.33% 7,928.85 55.42% 239.48 1.67% 82.12 0.57% 14,307.06

TOTAL 19,782.30 51.62% 17,508.34 45.68% 516.57 1.35% 518.36 1.35% 38,325.57

AGRICULTURE DEVELOPMENT RECREATION OTHER
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Figure 1.  The number of converted acres from the original classification by county. 
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Figure 2.  The number of converted wetlands from the original classification by county. 
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Wetland Conversion by NWI Class 
 
The highest percentage of the wetlands converted was emergent wetlands (39%), with open water at 
35% and forested at 14% (Table 3).  When comparing the wetland classes converted by acreage, the 
emergent wetlands still has the highest percentage (33%) but the forested classes is second with 
27% of the conversion acres (Table 4).  Therefore, the forested wetlands were converted at a lower 
rate then the emergent wetlands, but larger areas of forested wetlands were converted when the 
conversion happened. 
 

Table 3.  The number of wetlands converted by wetland class (1975/90 to 2006/7) 
 

Number % Number % Number % Number % Number % Number % Number % TOTAL

FULLY CONVERTED 50 0% 9,122 44% 1,672 8% 1,551 7% 8,375 40% 95 0% 78 0% 20,943
PARTIALLY CONVERTED 6 0% 1,343 23% 2,154 37% 1,136 20% 1,090 19% 11 0% 56 1% 5,796

TOTAL 56 0% 10,465 39% 3,826 14% 2,687 10% 9,465 35% 106 0% 134 1% 26,739

AQUATIC BED EMERGENT FORESTED SCRUB-SHRUB OTHEROPEN WATER SHORE

 
 

Table 4.  The acres of wetlands converted by wetland class (1975/90 to 2006/7) 
 

Acres % Acres % Acres % Acres % Acres % Acres % Acres % TOTAL

FULLY CONVERTED 24 0% 9,237 38% 4,231 18% 3,198 13% 6,581 27% 119 0% 630 3% 24,019
PARTIALLY CONVERTED 7 0% 3,345 23% 6,233 44% 3,040 21% 1,254 9% 32 0% 396 3% 14,307

TOTAL 30 0% 12,582 33% 10,464 27% 6,238 16% 7,835 20% 151 0% 1,026 3% 38,326

AQUATIC BED EMERGENT FORESTED SCRUB-SHRUB OTHEROPEN WATER SHORE

 
 

Wetlands not Included in the Original NWI 
 
It is important to note that wetlands identified in the update that were not in the original, are 
not necessarily newly created wetlands.  In many cases, the scale of the imagery used in the 
update (2005) was better than what was used in the original classification.  Therefore, many of 
the newly identified wetlands are small and would not necessarily have been seen in the 
original classification.  The average size of the added wetlands was 1.7 acres, which is below 
the minimum size (2-3 acres) of the original NWI mapping scale. 
 
There were a total of 122,825 additional wetlands that were added to the inventory, with a total of 
138,515 acres (Table 5).  Of the wetlands that were added, 72% were open water, followed by 
emergent, forested, other, aquatic bed, and shore.  The sizes of the additional open water wetlands 
averaged under an acre and were mostly “backyard ponds”.  There was a significant amount of 
emergent wetlands added to the inventory with 30,346 acres added.  The spatial distributions of the 
added wetlands are displayed in Figure 3 (number) and Figure 4 (acreage). 
 

Table 5.  The number and acres of additional wetlands by wetland class 
 

Acres % Acres % Acres % Acres % Acres % Acres % Acres % TOTAL

ADDITIONAL ACRES 641 0% 30,346 22% 24,559 18% 5,800 4% 51,760 37% 96 0% 25,313 18% 138,515
ADDITIONAL NUMBER 679 1% 19,523 16% 9,182 7% 2,902 2% 87,913 72% 54 0% 2,572 2% 122,825

AVERAGE SIZE 0.94 1.55 2.67 2.00 0.59 1.78 9.84 1.13

OPEN WATER SHORE OTHERAQUATIC BED EMERGENT FORESTED SCRUB-SHRUB
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Figure 3.  The number of additional wetlands by county 
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Figure 4.  The acreage of additional wetlands by county 
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Net Wetland Change from 1975-1990 to 2006-2007 
 
Please use extreme caution when using these numbers.  The reported change in wetlands is a 
useful planning tool, however, several factors should be used in conjunction with the reported 
numbers.  First, as described in the additional wetlands section above, the additional wetlands 
may or may not have existed during the original classification due to the scale of the original 
imagery.  Second, the wetland change does not consider wetland type in the analysis.  All 
wetlands are not created equal when determining habitat value or function.  For instance, a 
net gain of 5,000 acres in a county may sound good, but if there was a loss of 10,000 acres of 
emergent wetlands and a gain of 15,000 acres of open water (backyard ponds) than this would 
not necessarily be good as far as habitat value. 
 
For the state of Ohio, there was a net change of 96,086 wetlands with a gain of 100,189 acres (Table 
6 and 7).  The only wetland class that lost wetlands was Unconsolidated Shore.  However, the 
scrub-shrub class had a loss when looking at net change in wetland acreage.  The wetland losses 
(number) were limited Marion County, with acreage loss limited to Lake, Summit, and Williams 
Counties (Figure 5 and 6). 
 
 
 

Table 6.  The net change in wetland numbers from 1975-90 to 2006-7 
 

Number % Number % Number % Number % Number % Number % Number % TOTAL

CONVERTED NUMBER 56 0% 10,465 39% 3,826 14% 2,687 10% 9,465 35% 106 0% 134 1% 26,739
ADDITIONAL NUMBER 679 1% 19,523 16% 9,182 7% 2902 2% 87913 72% 54 0% 2572 2% 122,825

TOTAL 623 9,058 5,356 215 78,448 -52 2,438 96,086

AQUATIC BED EMERGENT FORESTED SCRUB-SHRUB OPEN WATER SHORE OTHER

 
 
 
 

Table 7.  The net change in wetland acreage from 1975-90 to 2006-7 
 

Acres % Acres % Acres % Acres % Acres % Acres % Acres % TOTAL

CONVERTED ACRES 30 0% 12,582 33% 10,464 0 6,238 16% 7,835 0 151 0 1,026 3% 38,326
ADDITIONAL ACRES 641 0% 30,346 22% 24,559 18% 5,800 4% 51,760 37% 96 0% 25,313 18% 138,515

TOTAL 610 17,764 14,095 -439 43,925 -54 24,287 100,189

AQUATIC BED EMERGENT FORESTED SCRUB-SHRUB OPEN WATER SHORE OTHER
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Figure 5.  The net change in wetland numbers by county 
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Figure 6.  The net change in wetland acreage by county 
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Field Verification 
 
The overall accuracy based on the field verification of the wetland delineation was 94% (1291 out 
of 1374).  This means that 94% of the time the updated NWI classified a wetland, it was verified as 
a wetland in the field.  Of the wetlands that were misclassified, 47% (39 of the 83) were when the 
interpretation was an emergent wetland, but the field verification was converted due to agriculture.  
The comments of some of the misclassified emergent/agricultural class contained notes on seeing 
wetland vegetation or depressions.  Due to the variation in interpreting wet agricultural fields in the 
field and the PEMA class from photos may be the cause of this confusion. 
 
The overall accuracy based on the field verification of the wetland class identification was 77%.  
This means that 77% of the time the updated NWI classified a wetland class (open water, aquatic, 
emergent, shrub, forested), it was verified as they wetland class in the field.  A majority (54%) of 
the within class errors were on wetlands there were under an acre in size and were between the 
emergent, shrub, and forested class.  These classes are very hard to distinguish from aerial photos at 
that size due to nearby tree cover.  Very few (17%) of the misclassifications were on wetlands over 
5 acres in size. 
 
Additional work needs to be done on the assessment of the updated NWI classification, particularly 
in the between class errors and determining the accuracy of the classes at different scales.  It would 
also be interesting to determine if there were significant differences between counties. 
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Appendix A – Data Contacts 
 
 
 
NWI Data Contacts: 
 
 
Bruce R. Droster Brian Huberty 
Cartographer & NWI MGD Administrator Regional NWI Coordinator 
U.S. Geological Survey, Water Resources Division U.S. Fish and Wildlife Service 
Cartography and Publishing Program R-3 Ecological Services 
505 Science Drive 1 Federal Drive, Mail Stop 4056 
Madison, WI  53711-1061 Ft Snelling, MN 55111-4056 
 
Phone: (608) 238-9333  ext. 144 Direct Phone (612) 713-5332 
Fax:  (608) 238-9334 Fax (612) 713-5292 
email: bdroster@usgs.gov brian_huberty@fws.gov 
 
 
Ohio NWI Scans 
 
 
Brian Huberty      Madge Fitak 
Regional NWI Coordinator    Ohio Geological Survey 
U.S. Fish and Wildlife Service    2045 Morse Road Bldg C-1 
R-3 Ecological Services     Columbus, OH 43229 
1 Federal Drive, Mail Stop 4056  
Ft Snelling, MN 55111-4056 
 
Direct Phone (612) 713-5332    Phone: 614-265-6576 
Fax (612) 713-5292     Fax: 614-447-1918 
brian_huberty@fws.gov     e-mail: madge.fitak@dnr.state.oh.us 
 
 

Ohio Photos 
 
2006/07 Spring CIR Photos     NAIP 2004 Summer 

 
David Crecelius, GISP       Bob Parkinson 
Applications/GIMS Administrator      State GIS Coordinator 
Office of Information Technology      USDA NRCS 
Ohio Department of Natural Resources     200 N. High St., Room 522 
614-265-6776       Columbus, OH  43215 
Dave.Crecelius@dnr.state.oh.us     614-255-2489 
        bob.Parkinson@oh.usda.gov 
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Appendix C – Wetland Statistics by 
County 

 
 



COUNTY Original # Full Convert # Part Convert # Total Convert # Total Convert % Additionl # Net Wetland # Original Acres Convert Acres Additional Acres Avg Size Conv Avg Size Add Net Acreage

Adams 2,031 133 0 133 0.07 2,981 2,848 2,890.61 125.41 1,794.83 0.94 0.60 1,669.42
Allen 2,650 259 38 297 0.11 1,243 946 4,807.19 169.28 987.47 0.57 0.79 818.18
Ashland 2,572 244 68 312 0.12 1,201 889 8,277.12 439.54 1,889.31 1.41 1.57 1,449.77
Ashtabula 9,464 633 190 823 0.09 3,484 2,661 63,398.61 1,557.96 2,459.05 1.89 0.71 901.09

Athens 2,711 140 25 165 0.06 961 796 6,161.92 205.30 519.59 1.24 0.54 314.29
Auglaize 2,422 249 26 275 0.11 600 325 5,391.34 131.08 838.10 0.48 1.40 707.03
Belmont 1,690 335 25 360 0.21 2,293 1,933 6,494.03 430.57 2,913.46 1.20 1.27 2,482.89
Brown 3,306 314 4 318 0.10 3,413 3,095 5,180.35 107.59 1,755.87 0.34 0.51 1,648.28
Butler 3,079 470 3 473 0.15 1,589 1,116 5,544.38 216.00 1,297.26 0.46 0.82 1,081.26
Carroll 1,257 88 67 155 0.12 1,161 1,006 7,748.60 321.29 2,558.64 2.07 2.20 2,237.36

Champaign 2,714 228 35 263 0.10 977 714 4,755.68 197.58 1,235.22 0.75 1.26 1,037.64
Clark 1,315 134 34 168 0.13 1,058 890 4,782.41 152.19 2,042.99 0.91 1.93 1,890.81
Clermont 4,522 434 68 502 0.11 1,908 1,406 9,532.65 383.06 1,105.93 0.76 0.58 722.88
Clinton 1,087 60 10 70 0.06 734 664 2,120.57 51.25 771.61 0.73 1.05 720.36
Columbiana 3,292 278 75 353 0.11 2,567 2,214 10,249.85 524.58 1,497.34 1.49 0.58 972.76
Coshocton 2,169 258 107 365 0.17 2,147 1,782 9,828.75 1,061.34 4,404.63 2.91 2.05 3,343.29

Crawford 2,873 397 38 435 0.15 584 149 5,798.01 262.62 1,225.93 0.60 2.10 963.31
Cuyahoga 1,376 271 175 446 0.32 1,205 759 5,871.29 836.38 1,291.77 1.88 1.07 455.39
Darke 2,020 45 1 46 0.02 2,207 2,161 2,984.17 35.84 2,192.16 0.78 0.99 2,156.32
Defiance 1,406 105 92 197 0.14 1,865 1,668 6,375.15 344.05 1,002.24 1.75 0.54 658.20
Delaware 4,013 530 86 616 0.15 1,746 1,130 11,830.39 259.53 1,430.32 0.42 0.82 1,170.79
Erie 958 69 74 143 0.15 514 371 8,666.43 477.25 703.93 3.34 1.37 226.68

Fairfield 2,154 100 14 114 0.05 1,005 891 4,966.91 148.13 769.42 1.30 0.77 621.29
Fayette 617 110 13 123 0.20 654 531 1,995.84 82.39 1,256.76 0.67 1.92 1,174.37
Franklin 3,229 618 132 750 0.23 1,442 692 7,913.31 910.67 1,802.28 1.21 1.25 891.62
Fulton 1,456 160 241 401 0.28 1,457 1,056 5,722.01 494.09 1,752.18 1.23 1.20 1,258.09
Gallia 2,855 76 1 77 0.03 1,328 1,251 5,424.34 60.57 614.22 0.79 0.46 553.66
Geauga 3,546 111 145 256 0.07 2,875 2,619 31,855.86 849.03 2,534.42 3.32 0.88 1,685.39

Greene 1,230 123 4 127 0.10 523 396 2,464.95 69.81 621.55 0.55 1.19 551.74
Guernsey 1,707 247 127 374 0.22 1,871 1,497 14,805.20 1,356.91 5,279.26 3.63 2.82 3,922.35
Hamilton 1,537 275 1 276 0.18 590 314 9,842.48 226.37 1,116.84 0.82 1.89 890.47
Hancock 1,509 96 74 170 0.11 1,218 1,048 4,861.60 268.54 1,146.76 1.58 0.94 878.22
Hardin 2,388 310 35 345 0.14 1,078 733 3,835.95 228.23 2,694.59 0.66 2.50 2,466.36
Harrison 2,185 486 197 683 0.31 1,233 550 11,571.50 1,253.24 2,624.74 1.83 2.13 1,371.50

Henry 665 75 49 124 0.19 999 875 5,430.23 258.03 731.92 2.08 0.73 473.89  



COUNTY Original # Full Convert # Part Convert # Total Convert # Total Convert % Additionl # Net Wetland # Original Acres Convert Acres Additional Acres Avg Size Conv Avg Size Add Net Acreage

Highland 1,948 119 10 129 0.07 1,120 991 4,533.21 43.02 814.15 0.33 0.73 771.12
Hocking 2,216 97 23 120 0.05 760 640 3,688.65 127.68 307.07 1.06 0.40 179.39
Holmes 1,499 183 75 258 0.17 998 740 5,324.47 403.95 693.40 1.57 0.69 289.45
Huron 2,452 185 41 226 0.09 1,502 1,276 16,063.53 606.14 2,289.13 2.68 1.52 1,683.00

Jackson 2,690 376 5 381 0.14 1,685 1,304 8,158.15 435.74 945.83 1.14 0.56 510.09
Jefferson 1,784 266 12 278 0.16 823 545 5,030.35 408.51 876.91 1.47 1.07 468.40
Knox 2,520 246 52 298 0.12 1,105 807 6,177.18 284.18 1,079.28 0.95 0.98 795.11
Lake 1,413 172 157 329 0.23 966 637 4,760.89 750.96 524.89 2.28 0.54 -226.07
Lawrence 1,774 65 3 68 0.04 1,017 949 3,688.16 41.83 441.88 0.62 0.43 400.05
Licking 4,996 219 35 254 0.05 1,431 1,177 7,315.92 314.87 958.02 1.24 0.67 643.15

Logan 3,634 364 67 431 0.12 1,057 626 12,017.01 388.44 2,725.27 0.90 2.58 2,336.83
Lorain 3,351 332 167 499 0.15 2,244 1,745 8,335.51 785.30 1,792.94 1.57 0.80 1,007.64
Lucas 1,413 165 176 341 0.24 1,902 1,561 14,725.11 527.95 1,802.15 1.55 0.95 1,274.20
Madison 1,268 30 3 33 0.03 398 365 2,500.90 21.05 374.77 0.64 0.94 353.72
Mahoning 3,480 312 53 365 0.10 1,683 1,318 17,304.32 697.86 1,080.71 1.91 0.64 382.85
Marion 3,558 730 110 840 0.24 621 -219 4,594.52 484.33 1,305.80 0.58 2.10 821.47

Medina 3,841 336 321 657 0.17 4,038 3,381 10,291.96 864.69 2,116.03 1.32 0.52 1,251.34
Meigs 2,336 278 0 278 0.12 931 653 4,620.28 294.43 538.89 1.06 0.58 244.46
Mercer 1,780 190 5 195 0.11 691 496 14,071.17 88.52 1,157.07 0.45 1.67 1,068.55
Miami 1,689 174 16 190 0.11 452 262 3,417.82 137.15 416.30 0.72 0.92 279.15
Monroe 700 56 0 56 0.08 522 466 1,994.91 58.56 324.83 1.05 0.62 266.27
Montgomery 1,833 113 18 131 0.07 651 520 4,749.07 110.13 569.08 0.84 0.87 458.95

Morgan 1,351 152 2 154 0.11 1,808 1,654 4,814.97 248.19 932.14 1.61 0.52 683.95
Morrow 4,390 214 13 227 0.05 855 628 4,095.57 156.59 551.15 0.69 0.64 394.56
Muskingum 3,049 387 103 490 0.16 2,313 1,823 15,982.86 934.69 3,529.36 1.91 1.53 2,594.67
Noble 1,127 245 1 246 0.22 2,370 2,124 5,456.82 545.00 2,248.46 2.22 0.95 1,703.46
Ottawa 2,124 213 218 431 0.20 1,052 621 19,329.62 1,310.17 2,321.05 3.04 2.21 1,010.88
Paulding 834 97 51 148 0.18 1,460 1,312 6,182.95 385.40 1,314.68 2.60 0.90 929.29

Perry 3,681 82 11 93 0.03 768 675 5,492.64 106.91 504.19 1.15 0.66 397.28
Pickaway 1,820 55 5 60 0.03 754 694 5,638.13 76.99 1,032.31 1.28 1.37 955.32
Pike 2,065 69 16 85 0.04 654 569 4,612.80 138.04 348.40 1.62 0.53 210.35
Portage 4,720 364 356 720 0.15 1,942 1,222 36,067.32 1,271.69 2,256.48 1.77 1.16 984.78
Preble 1,452 93 0 93 0.06 754 661 1,860.35 38.79 656.41 0.42 0.87 617.63
Putnam 808 78 9 87 0.11 1,310 1,223 5,174.54 168.51 2,720.48 1.94 2.08 2,551.97

Richland 3,781 511 186 697 0.18 1,211 514 9,438.74 592.55 827.77 0.85 0.68 235.22
Ross 3,064 339 17 356 0.12 1,742 1,386 9,872.95 800.07 1,262.25 2.25 0.72 462.18  

Ducks Unlimited, Inc. 118 11/6/2009  



COUNTY Original # Full Convert # Part Convert # Total Convert # Total Convert % Additionl # Net Wetland # Original Acres Convert Acres Additional Acres Avg Size Conv Avg Size Add Net Acreage

Sandusky 783 57 80 137 0.17 747 610 9,570.48 409.91 3,541.89 2.99 4.74 3,131.98
Scioto 1,927 153 0 153 0.08 2,224 2,071 6,720.74 79.30 2,116.40 0.52 0.95 2,037.10
Seneca 900 83 19 102 0.11 912 810 5,333.52 237.84 566.01 2.33 0.62 328.17
Shelby 2,630 208 20 228 0.09 1,206 978 3,715.53 102.61 883.57 0.45 0.73 780.96

Stark 3,373 443 118 561 0.17 2,269 1,708 15,178.57 1,134.86 2,540.00 2.02 1.12 1,405.14
Summit 3,000 234 144 378 0.13 1,618 1,240 15,213.76 902.73 808.52 2.39 0.50 -94.21
Trumbull 7,565 615 209 824 0.11 1,939 1,115 47,594.54 1,432.89 1,849.36 1.74 0.95 416.47
Tuscarawas 1,744 276 127 403 0.23 1,873 1,470 11,310.94 1,108.29 9,675.10 2.75 5.17 8,566.80
Union 3,556 285 5 290 0.08 1,083 793 2,897.05 115.69 1,152.31 0.40 1.06 1,036.62
Van Wert 1,121 182 16 198 0.18 506 308 1,669.27 68.52 425.76 0.35 0.84 357.24

Vinton 2,317 497 100 597 0.26 1,321 724 8,711.92 868.27 1,002.16 1.45 0.76 133.89
Warren 3,676 269 5 274 0.07 1,149 875 7,930.04 167.27 816.42 0.61 0.71 649.16
Washington 2,271 162 0 162 0.07 1,377 1,215 6,979.18 184.30 944.19 1.14 0.69 759.89
Wayne 2,844 300 188 488 0.17 1,810 1,322 12,672.04 1,101.68 5,789.18 2.26 3.20 4,687.51
Williams 3,281 456 92 548 0.17 1,008 460 12,546.51 1,185.60 949.92 2.16 0.94 -235.68
Wood 847 115 39 154 0.18 2,104 1,950 6,953.30 378.49 1,827.55 2.46 0.87 1,449.06

Wyandot 2,338 240 24 264 0.11 1,378 1,114 4,191.71 152.85 1,124.31 0.58 0.82 971.45

TOTAL 214,619 20,943 5,797 26,740 0.13 122,825 96,086 785,952.12 38,326.26 138,514.75 1.39 1.18 100,189  
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